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CHAPTER 1

Basic image statistics

Contents:

1.1 Before you begin

• Download the images for today from: http://physics.mnstate.edu/craig/float.zip

• Unzip the file by double clicking on it

• Open AstroImageJ (just called ImageJ on the computer)

1.2 Overview

In today’s lab you will:

• Get more experience working with image sequences in AstroImageJ.

• Learn why working with stacked calibration images is better than working with single calibration images.

• Calculate the gain and read noise for the Apogee Alta U9 CCD used at Feder Observatory.

1.3 Sequences of Images in Astro ImageJ

1.3.1 Before you begin

You cannot open a sequence of imgaes in AstroImageJ until you have opened at least one FITS file...so start by opening
the first image for this lab.

Note: FITS is a format for storing data in a way that any computer platform can read if it has the right software
installed. It is very widey used in astronomy in part because you can store both the data itself and information about
the data, called meta-data, in the file. The meta-data is stored in the FITS header and the data was the image itself.

Warning: There are two very different sets of menus displayed in AstroImageJ depending on whether the toolbar
or an image window are on top in the display.

3

http://physics.mnstate.edu/craig/float.zip


ObsAstro Documentation, Release 0.1

1.3.2 Opening a sequence of images

The idea here is that you need to tell AstroImageJ two things:

• Which folder the images are in

• Which files from the folder you want to load into a sequence.

1. Make sure you have an image window on top.

2. From the file menu, select “Open image sequence in new window...”

3. Choose the folder containing the images you want to open in a stack.

4. To choose the images to put in the sequence you have a few options:

• Use them all; just click OK in the window Sequence Options

• Choose the starting and ending image by specifying the number of the starting image and the increment.

• Enter a phrase or number that is in the name of all of the images that you want to open. Note that CaSe
mAtTers; if the file name contains the word ‘bias’, for example, but you put ‘Bias’ in the box in Sequence
Options, AstroImageJ will find no images.

• Enter a more complex pattern that matches the names of the files you want to include.

Warning: Opening more than a few dozen images in a sequence may bring your computer to a grinding halt be-
cause by default AstroImageJ loads them all into the computer’s memory. If you select Use virtual stack you avoid
that problem because AstroImageJ only reads in single images when it needs them. That slows down processing a
bit, so for small numbers of images it is easier to not use a virtual stack.

Pattern matching examples

AstroImageJ allows you to enter fairly complex patterns to match file names. In those patterns some symbols have a
special meaning:

• Use a period . represent any single character.

• Use an asterisk * to represent zero or more of whatever character came before it.

• Put characters in square brackets [] to represent any one of the characters in the brackets.

For example, the patter .* will always match all files because the period matches any character and the asterisk indicates
zero or more of those characters.

The pattern twi-.*bias.* would match all files whose name starts with twi-, has zero or more characters, then the word
bias, followed by zero or more characteres.

The pattern flood-.*00[1-9]B_flt.fit matches any files whose name starts with flood-, followed by any of the numbers
001 through 009, then B_flt.fit

Todo
1. For each file name below explain why the name would or would not match the pattern twi-.*bias.*

• Twi-bias.fit

• twi-diffuser-flat-001bias.fit

• twi-diffuser-flat-001bias_flt.fit

• twi-diffuser-flat-001bIas.fit
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2. Look at the list of the files in the folder for_gain. For each of the items below come up with a pattern that
matches the right files. Check your patterns by starting to open an image sequence in AstroImageJ, selecting the
folder for_gain, entering the pattern in the right place, and verifying that the correct number of files matches.

(a) All bias images that have “twi” in the name (should be 11 files)

(b) The images in the R band (R is in the file name) that also have “flood” in the name and are number 001
through 003 (should be 3 files).

(c) The images in the I band with “flood” in the name (10 items)

(d) The images in the I band with “flood” in the name whose number is odd (001, 003, etc) (should be 5
images)

1.4 Basic image statistics

The rule of thumb to remember is that combining images reduces noise. For science images that is largely because
combining images is equivalent to a longer exposure, which will have more light. For flat images the reasoning is
similar; a flat image is, after all, just collecting light in a special configuration, so more light will mean better signal.

For bias images (and to a large extent our dark images, which are largely bias) combining images reduces the random
error introduced by the electronics that read out the CCD. The series of activities and questions below lead you through
what changes as you look at combinations of bias images and ask you to think about why those changes occur.

1.4.1 Setup

• Open one of the bias images in the folder for_gain.

• Make a histogram of the image and choose, based on the histogram, a reasonable upper and lower limit. Use
this same upper and lower limit for all of the rest of the histograms you make.

• Open a sequence in a new window that contains all of the bias images in the folder (they all have the word bias
in the name).

1.4.2 Combining by averaging, and some basic patterns

Todo
1. Make a histogram for a single bias image. Note the width of the bias histogram, which is twice the standard

deviation, and the mean.

2. Combine four of the bias images. Do this by:

• clicking on sequence window so that it is on top

• clickking on the AstroImageJ toolbar to make sure the correct menus are displayed

• selecting Z-Project from the Stacks menu in the Image menu (i.e. Image -> Stacks -> Z-Project) and...

• ...choosing appropriate values for the starting and ending image in the sequence, and...

• ...choose average as the method of combining.

• Be sure to write down the name of the combined image.

3. Make a histogram of the combination of four bias images. Compare the mean and standard deviation of the
distribution for the combined images with the same numbers for the single image.

1.4. Basic image statistics 5
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4. Repeat for 8 bias images; note the mean and standard deviation.

5. Repeat again for all 16 bias images; note the mean and standard deviation.

6. Describe in words:

(a) How the histogram changes as you increase the number of images in the stack.

(b) How the mean changes as you increase the number of images.

(c) How the standard deviation changes as you increase the number of images.

7. For this type of error it can be shown that the amount of noise (i.e. the standard deviation) should be inversing
proportional to the square root of the number of images. Does this seem to be true, at least roughly, for the
histograms you just compared?

1.4.3 Different ways of combining: average vs median

Todo
1. Combine four images using median to Z-project the images, and make a histogram of the combined image.

2. Combine 16 images using median to Z-project the images, and make a histogram of the combing image.

3. Does the pattern you observed for the change in noise as you increase the number of images still hold for median
combining?

4. Compare the mean and standard deviation of these histograms with the corresponding mean and standard devia-
tion from the images combined using the average. Which results in less noise, combing by average or combining
by median?

5. Why might you median combine images even though there is slightly less noise if you combine images by
averaging?

1.5 Calculating gain

Please take a look in Howell, pages 71-73, for a description of how to calculate gain and read noise from bias and flat
images. The relevant equations are also on the board at the front of the room.

Note that to calculate the gain and read noise there are a few things we need to be able to do:

• Select a region of an image that doesn’t include the edges, because Howell suggests that the pixels at the edges
tend to be more problematic, and these images may have an overscan region.

• Calculate the average value of the pixels in that region.

• Calculate the difference between two images (i.e. the result of subtracting one image from the other).

• Find the standard deviation of pixels in that difference image in the same region selected orginally.

In principle, none of these things are hard. In practice it also isn’t that hard...once you know how to do it. For that
we’ll take a detour into how to use AstroImageJ.
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1.6 Measurements in Astro ImageJ

1.6.1 Selecting a region

In the AstroImageJ toolbar are a number of selection tools. They include the line selection tool, a rectangle selection
tool, and several others.

• Start by selecting a rectangular region in one of your bias images.

• Now try selecting exactly the same region in a different bias image. Can you? Don’t waste a lot of time trying
please!

To take consistent measurements across a series of images it would be helpful to be able to tell AstroImageJ explicitly
what region you want. You can do that by:

• Click on the toolbar so it is on top.

• Select Specify under the Selection menu under the Edit (i.e. Edit -> Selection -> Specify)

• You can set the size and position of the selection.

Todo
1. Where is the origin used for the x and y position? In other words, where in the image is the point (0,0)?

2. What is the position of the center of the image?

1.6.2 Taking a measurement

Once you have selected a region you can measure a number of the properties of the pixels in that region. You can
control which things are measured by going to one of two menus:

• Go to Analyze -> Set Measurements... if the AstroImageJ toolbar is on top, or...

• Go to Edit -> Measurement Settings... if an image window is on top.

To make a measurement, type Cmd-M, or select Analyze -> Measure.

Note: Be sure that you are set up to measure at least the bounding rectangle, mean, median and standard deviation of
the selected region.

Todo
1. Measure the mean pixel value and the standard deviation of the pixel value for one of the images you have open.

1.7 Image Arithmetic in AstroImageJ

AstroImageJ can do basic arithmetic with images: add, subtract, multiply, and divide them. To do arithmetic, go to the
Process menu, and select either Image Calculator or Image/stack calculator (which you select depends on whether
there is the toolbar or an image is on top).

Warning: Always have AstroImageJ display the result in a new window; you want to be sure to avoid accidentally
overwriting or modifying the original data.

1.6. Measurements in Astro ImageJ 7
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Let’s try a couple things to make sure you understand what the image calculator does.

Todo
1. Imagine subtracting an image from itself. What should the result be? Use AstroImageJ to subtract an image

from itself. Does the result match your expectaion?

2. Imagine dividing an image by itself. What should the result be? Use AstroImageJ to divide an image by itself.
Does the result match your expectation.

1.8 Calculating gain: step-by-step

1.8.1 Setup

• To avoid confusion, please close all open image windows.

• Pick two bias images and open them in separate windows.

• Pick two flat images of the same type (flood or twi) and the same filter and open them in separate windows.

1.8.2 Calculating gain

For the gain we will need to:

• Select the same region in each image

• Find the average pixel value in that region in each of the four images.

• Calculate the difference between the two bias images

• Calculate the difference between the two flat images

• Find the standard deviation of the pixel values in the same region in each of the difference images.

Let’s do that:

Todo
1. Write down the names of the images you chose.

2. Select a region and write down its width, height, and x and y position.

3. Find the average pixel value in that region in each image you have open. Write them down, clearly indiciating
which measure goes with which image.

4. Calculate the difference between the two bias images.

5. Calculate the difference between the two flat images.

6. Measure the standard deviation in the region you chose in each of the two difference images. Write the result
down, clearly indicating which measurement goes with which difference image.

7. Calculate the gain for the CCD using the formula in Howell’s book.

8. Calculate the read noise for the CCD using the formula in Howell’s book.

8 Chapter 1. Basic image statistics
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1.9 Questions

Todo
1. For each file name below explain why the name would or would not match the pattern twi-.*bias.*

• Twi-bias.fit

• twi-diffuser-flat-001bias.fit

• twi-diffuser-flat-001bias_flt.fit

• twi-diffuser-flat-001bIas.fit

2. Look at the list of the files in the folder for_gain. For each of the items below come up with a pattern that
matches the right files. Check your patterns by starting to open an image sequence in AstroImageJ, selecting the
folder for_gain, entering the pattern in the right place, and verifying that the correct number of files matches.

(a) All bias images that have “twi” in the name (should be 11 files)

(b) The images in the R band (R is in the file name) that also have “flood” in the name and are number 001
through 003 (should be 3 files).

(c) The images in the I band with “flood” in the name (10 items)

(d) The images in the I band with “flood” in the name whose number is odd (001, 003, etc) (should be 5
images)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/aij_sequences.rst, line 55.)

Todo
1. Write down the names of the images you chose.

2. Select a region and write down its width, height, and x and y position.

3. Find the average pixel value in that region in each image you have open. Write them down, clearly indiciating
which measure goes with which image.

4. Calculate the difference between the two bias images.

5. Calculate the difference between the two flat images.

6. Measure the standard deviation in the region you chose in each of the two difference images. Write the result
down, clearly indicating which measurement goes with which difference image.

7. Calculate the gain for the CCD using the formula in Howell’s book.

8. Calculate the read noise for the CCD using the formula in Howell’s book.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/gain_calc_detail.rst, line 24.)

Todo
1. Imagine subtracting an image from itself. What should the result be? Use AstroImageJ to subtract an image

from itself. Does the result match your expectaion?

2. Imagine dividing an image by itself. What should the result be? Use AstroImageJ to divide an image by itself.
Does the result match your expectation.

1.9. Questions 9
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(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_arithmetic.rst, line 13.)

Todo
1. Where is the origin used for the x and y position? In other words, where in the image is the point (0,0)?

2. What is the position of the center of the image?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_measurements.rst, line 18.)

Todo
1. Measure the mean pixel value and the standard deviation of the pixel value for one of the images you have open.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_measurements.rst, line 37.)

Todo
1. Make a histogram for a single bias image. Note the width of the bias histogram, which is twice the standard

deviation, and the mean.

2. Combine four of the bias images. Do this by:

• clicking on sequence window so that it is on top

• clickking on the AstroImageJ toolbar to make sure the correct menus are displayed

• selecting Z-Project from the Stacks menu in the Image menu (i.e. Image -> Stacks -> Z-Project) and...

• ...choosing appropriate values for the starting and ending image in the sequence, and...

• ...choose average as the method of combining.

• Be sure to write down the name of the combined image.

3. Make a histogram of the combination of four bias images. Compare the mean and standard deviation of the
distribution for the combined images with the same numbers for the single image.

4. Repeat for 8 bias images; note the mean and standard deviation.

5. Repeat again for all 16 bias images; note the mean and standard deviation.

6. Describe in words:

(a) How the histogram changes as you increase the number of images in the stack.

(b) How the mean changes as you increase the number of images.

(c) How the standard deviation changes as you increase the number of images.

7. For this type of error it can be shown that the amount of noise (i.e. the standard deviation) should be inversing
proportional to the square root of the number of images. Does this seem to be true, at least roughly, for the
histograms you just compared?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/stats_1.rst, line 18.)

Todo
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1. Combine four images using median to Z-project the images, and make a histogram of the combined image.

2. Combine 16 images using median to Z-project the images, and make a histogram of the combing image.

3. Does the pattern you observed for the change in noise as you increase the number of images still hold for median
combining?

4. Compare the mean and standard deviation of these histograms with the corresponding mean and standard devia-
tion from the images combined using the average. Which results in less noise, combing by average or combining
by median?

5. Why might you median combine images even though there is slightly less noise if you combine images by
averaging?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/stats_1.rst, line 44.)

Todo
1. What is different about the first image in the sequence? Look near pixel coordinates (1480, 820)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 12.)

Todo
1. Can you see the defect in the image made by averaging the stack? Why?

2. Can you see the defect in the image made by median combining the stack? Why?

3. In which stacked image is the defect more visible, the average or the median?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 26.)

Todo
1. If you haven’t yet, normalize the sequence of flat images you have open. Is the average pixel value in the image

roughly the same in each image after normalization? Why isn’t the average pixel value the same as the median
pixel value you set in the normalization dialogue box?

2. Suppose one of the original images had a median pixel value of 23,200 and that you want to have want the
median after normalization to be 2. Describe in detail what you need to do to the image to normalize (detail in
the sense of the math operations you would need to carry out if you were to normalize by hand, not details of
how to do it in AstroImageJ) and explain why your answer is correct.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 52.)

Todo
1. Make a master bias frame using all of the bias frames in the folder and save the result as a FITS image. Make a

note of:

• Which files went into the master.

• How you combined the files.

• How many files went into the master.

• What you called the master bias frame.

1.9. Questions 11
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(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/masters.rst, line 15.)

Todo
1. Make a master dark. Use all of the files in the float folder that start with twi and have D15 in the name.

Combine using a median, and save the result as a FITS image. Make a note of:

• Which files went into the master.

• How you combined the files.

• What the exposure time was for these darks.

• What you called the master dark frame.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/masters.rst, line 43.)

Todo
1. Double-check the exposure time of the flat you opened. Does it match the exposure time of the master dark you

created?

2. Use the image calculator to subtract your master dark from the flat frame that you opened.

3. In principle, the pixel values are now all due to light that fell on the CCD. Pick a pixel, and convert the value
from ADU to photons using the gain you calculated earlier. How many photons was it?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/reduce_a_flat.rst, line 8.)

Todo
1. Open up SIMBAD and look up the information on your target. Make note of any other common names for your

target, its position (in J2000 coordinates), and its magnitude (NOTE: You may want to save a bookmark to your
object’s SIMBAD page).

2. Write down a list of the kind of observations you will need to make for your project (NOT INCLUDING the
biases, darks, and flats you would have to shoot for any telescopic observations). Include the number of images
and which filters you will need to use. You should also note if the images need to be in very dark skies or if
you can shoot in brighter (possibly moonlit) skies. WARNING: One part of planning we are not addressing yet
is estimating how long you need to make your exposures. This is critical because it affects how much you can
actually shoot each night. We will be addressing this next week.

3. Edit the my_objects_list.txt text file to include your target(s) as the first object(s) on the list. You can also delete
any lines for objects you do not intend to observe if you wish.

4. Open up jSkyCalc and load the objects list. Set the date in jSkyCalc to the appropriate date. When is sunset and
sunrise for the night you are checking? You may need to know this to plan for twilight flats.

5. When does twilight end (evening) and begin (morning)? You may need these times to plan for twilight flats and
to know when science observing can occur.

6. Set the time in jSkyCalc to twilight for that evening. What is the Hour Angle of your target? What does this
mean?

7. What is the airmass profile for your target? What time of night will your target be high enough for it to be a
good time to observe your object, if any? Clarify how you reached this decision (e.g. - What did you look for to
make this decision?)

12 Chapter 1. Basic image statistics
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8. Is the moon going to be a problem for you on March 1-3?

9. Check the “seasonal observability” and confirm when during the spring semester would be a good time of year
to observe the target. Make note of those times as well as how you reached the decision (e.g. - Did you consider
just airmass or did you also need to consider the phase of the moon?)

10. Lastly, to help with you identifying the target at the telescope, put together a Finder Chart with a 20 arcminute wide field of view with a limit of about 17th magnitude. Use one of the following services:

• SIMBAD or

• the MAPS Catalog Finder Chart service or

• AAVSO Variable Star Plotter service.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/03_planning_observations/checking.rst, line 8.)

Todo
1. What project do you think you would like to attempt?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/03_planning_observations/choosing.rst, line 67.)

Todo
1. Suppose your dark frames were exposed for 30 seconds but your science images were 90 second exposures.

Explain how you would need to adjust the dark current images to use them for removing dark current from your
science image.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduce_science_overview.rst, line 44.)

Todo
1. If for some reason you wanted to could you still, even in case 2, do the data reduction the way it is in case 1?

Explain.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduce_science_overview.rst, line 59.)

Todo
1. Examine the FITS headers of the images. Which of the two data reduction cases in the previous discussion

applies here? Explain.

2. Reduce the science image.

(a) First, subtract of the bias/dark current or the dark frame (depending on which case applies here). Identify
one or more features of the image that visibly changed when you did this step of the calibration.

(b) Second, use the flat field to correct the illumination. Describe what changes, if any you see in the image.
Hint: As with the previous step, you will need to use the image calculator.

3. Summarize, in your own words, the steps needed to reduce a science image.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduction_by_hand.rst, line 6.)

1.9. Questions 13
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Todo
1. As a refresher, write down the three basic types of calibration you do to images.

2. Open one of the science images you have been asked to reduce.

3. Based on the exposure time and filter of the image, what calibration files will you need?

4. Are there additional calibration images you need to calibrate the calibration images in the previous question? If
yes, what are they?

5. Are there calibration images you need that do not depend on exposure time or filter? What are they?

You should end this section of questions with a clear list of the calibration images you will need (e.g. flats in the Z
filter, darks with an exposure time of 120 hours).

Check your list with any one of the instructors before you move on.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/automated_reduction.rst, line 53.)

Todo
1. How many bias frames should be included by the this automated tool? Note: there is no fancy way to figure this

out. Look at the file names.

2. Does the master bias image that you produced look like a master bias should? By this point you should have
some rough idea of what a master bias looks like and you should have notes on what the typical pixel value is in
a bias frame. Check both of those things.

3. Compare your master bias image to the appropriate reference_images to make sure they are really the same. Do
that by loading both your master bias and ours and using AstroImageJ to take the difference or the ratio (what
would you expect for either?).

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_bias.rst, line 25.)

Todo
1. Review the list of calibration files you made in Get organized before you get going. How many master dark

images will you need to make?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_dark.rst, line 4.)

Todo
1. How many dark frames should be included by the this automated tool for each of the master darks you need to

create? Note: there is no fancy way to figure this out. Look at the file names.

2. Does the master dark image(s) that you produced look like a master dark should? By this point you should have
some rough idea of what a master dark looks like and you should have notes on what the typical pixel value is
in a dark frame. Check both of those things.

3. Compare your master dark image(s) to the appropriate reference_images to make sure they are really the same.
Do that by loading both your master dark(s) and ours and using AstroImageJ to take the difference or the ratio
(what would you expect for either?).

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_dark.rst, line 32.)
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Todo
1. Review the list of calibration files you made in Get organized before you get going. How many master flat

images will you need to make? What filter(s)?

2. What calibration frames will you need to make your master flat?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_flat.rst, line 6.)

Todo
1. How many flat frames should be included by the this automated tool for each of the master flats you need to

create? Note: there is no fancy way to figure this out. Look at the file names.

2. Does the master flat image(s) that you produced look like a master flat should? By this point you should have
some rough idea of what a master flat looks like and you should have notes on what the typical pixel value is in
a flat frame. Check both of those things.

3. Compare your master flat image(s) to the appropriate reference_images to make sure they are really the same. Do that by loading both your master flat(s) and ours and using AstroImageJ to take the difference.

• NOTE: If there turn out to be tiny differences, they may appear to be more significant than they are
when displayed, since AstroImageJ scales the image to the range of values in the image. A better test
might be taking the RATIO of your flat versus the reference flat image if your flat and our reference
flat are just offset from each other by a tiny but constant fraction.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_flat.rst, line 31.)

Todo
1. How many science frames should be included by the this automated tool? Note: there is no fancy way to figure

this out. Look at the file names.

2. Does the calibrated science image look sensible? By now you should be able to recognize if there are obvious
defects (e.g. dust donuts)

3. Compare your science image(s) to the appropriate reference_images to make sure they are really the same.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/reduce.rst, line 30.)

Todo
1. If you choose 𝐶 = 0, what is the instrumental magnitude for the star you measured?

2. Look at the table of magnitudes handed out (also available here). Does your instrumental magnitude match the
V magnitude of the star you chose? Should it?

3. What would you have to choose C to be for your magnitude to match the magnitude in the table?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/instrumental_mags_and_the_beauty_of_photometry.rst, line 24.)

Todo
1. Talk to someone who chose a different star than you did and calculate the difference in instrumental magnitude

between your two stars.
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2. Compare your difference in instrumental magnitude to the difference in the reported magnitudes of the two stars
in the table.

3. Try looking up your two stars in simbad and write down their V magnitudes according to simbad.

• do a coordinate search

• one format for entering coordinates is like: 2.703738h+42.77795d

• RA is first, in decimal hours, followed by declination in decimal degrees

4. Does the magnitude difference as calculated from simbad match what you get from the table we provided? Does
it match your image?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/instrumental_mags_and_the_beauty_of_photometry.rst, line 48.)

Todo
1. What is the FWHM of the star you took the seeing profile of?

2. What does the FWHM mean? Answer both in terms of what the acronym means and an explanation in plain
english what it represents.

3. What aperture size was chosen? How large is it compared to the FWHM (e.g. 2X, or half)?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/photometry_aij.rst, line 21.)

Todo
1. Write down, from the measurement table, for the star you chose:

• the RA and Dec (in decimal hours and decimal degrees)

• net counts (Source-Sky)

• source radius

• minimum and maximum sky radius

• Sky counts/pixel

• Source Error

• Source SNR

2. What was the net number of photons received from the star in the aperture? Hint: Don’t forget about the gain.

3. Pay attention to the folks up front for a brief lecture about error and signal-to-noise ratio (SNR). Take useful
notes.

4. Calculate the source error and SNR and compare to the values of each from AstroImageJ

5. What is the largest source of error?

6. Of the “noise” terms (dark, sky, read noise), which makes the largest contribution?

7. How could you reduce that source of noise?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/photometry_aij.rst, line 48.)

Todo
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1. Add three columns to your data table, one for the instrumental magnitudes of each of the three stars for which
you have photometry. NOTE: AstroImageJ calls the columns that contain the net counts (i.e. 𝑁Source − 𝑁Sky)
something like Source-Sky_T1 or Source-Sky_T2. Use a value of zero for C.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 17.)

Todo
1. Make a graph with airmass on the horizontal axis and instrumental magnitude on the vertical axis, like BGO

Fig. 7.4. Use the “target” star.

• Display the points as points not a line like the book does.

• Excel will pick stupid default values for the airmass values; be sure to at least change the minimum value
to something sensible.

2. Add a trendline to each of the data series. In the options for the trend line:

• Display the fit equation

• Display 𝑅2

3. What would the instrumental magnitude of this star be if corrected for the atmosphere? Hint: What does 𝑚0

represent, physically (mathematically it is the y-intercept of the line you fit to the data)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 35.)

Todo
1. Add the instrumental magnitudes of the other two stars to your graph. The graph should have three sets of points

on it, one set for each of the three stars (i.e. three data series, in Excel-speak).

2. Add trendlines to the new data series.

3. Do all three stars experience the same extinction coefficient, k? Why do you think that is?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 59.)

Todo
1. Open the image “reference-positions.fit” to get the RA and Dec for each of the stars you look at and write them

down in your notebook.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/multi_aperture_photometry.rst, line 36.)

Todo
1. Write down the FWHM, aperture size, inner sky radius and outer sky radius you chose.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/set_aperture_radius.rst, line 22.)

Todo
1. For my project to succeed, what do I need to actually accurately measure from my science images?
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(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/data_processing_questions.rst, line 6.)

Todo
1. Calibrated Astrometry: Do I need to know where my objects actually are in the sky? Do I need to be concerned

with their motion? Note: None of your projects this year involved tracking moving objects, so this is not critical.
That said, it is a good idea to calibrate your astrometry so that you know where each point in your image actually
is in the sky. Luckily for you, we have already calibrated all your images astrometrically using a software
package called astrometry.net.

2. Calibrated Photometry: Do you need to calibrate your photometry so that it can be compared to others?
That is, do you need to report calibrated magnitudes or can you stick to instrumental magnitudes? If you need
calibrated magnitudes, how would you go about getting them? What standard stars will you use?

3. Atmospheric Extinction Corrections: Do you need to be concerned with determining the extinction and red-
dening per airmass for your target? If so, how could you determine it?

4. Galactic Extinction Corrections: Do you need to be concerned with determining the amount of Galactic
extinction or reddening to your target? Why or why not?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/data_processing_questions.rst, line 11.)

Todo
1. Do you need to stack images in order to bring out faint features in your images? If so, what images do you need

to stack to produce what final images. How will you make sure the stacked images are aligned?

• If you are stacking science images you will need to align them first. Instructions for aligning are at
http://physics.mnstate.edu/craig/astro_project/align.html#align-the-images

• If you need them, instructions for stacking are at http://physics.mnstate.edu/craig/image_stats/stats_1.html#different-
ways-of-combining-average-vs-median

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/image_processing_questions.rst, line 6.)

Todo
1. For my project to succeed, what do I need to actually accurately measure from my science images?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/introduction.rst, line 25.)
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CHAPTER 2

Image reduction: overview and example

Contents:

2.1 Before you begin

• Download the images for today from: http://physics.mnstate.edu/craig/funny_flats.zip

• Unzip the file by double clicking on it

• Open AstroImageJ (just called ImageJ on the computer)

2.2 Median or Average?

2.2.1 Setup

1. Please close any open images.

2. Open, as an image sequence, all of the files in the folder images/funny_flats

• Remember, you need to open at least one FITS images before you have the option of opening a sequence!

Todo
1. What is different about the first image in the sequence? Look near pixel coordinates (1480, 820)

2.2.2 Stacking, two ways

Stack all 10 of the images in two different ways:

• Average intensity

• Median

then answer these questions...

Todo
1. Can you see the defect in the image made by averaging the stack? Why?

2. Can you see the defect in the image made by median combining the stack? Why?
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3. In which stacked image is the defect more visible, the average or the median?

2.2.3 Median magic: The ideal case

Each of the flat images in your sequence has a somewhat different average value, presumably because the light source
was fluctuating slightly in brightness. Furthermore, that variation is reasonably large (for this set of images the average
pixel value ranges from about 22,900 to 23,300). The result is that the presence of the comic ray tends to bias the
median towards slightly larger values at the position of the cosmic ray so that it is is not perfectly eliminated even
when you median combine 10 frames.

For something like flat frames you really want to be combining images that have the same light level (within the limits
of the read noise of the detector, anyway). Sometimes you can get that by having a very, very steady light level (a
floodlight ought to deliver that, but doesn’t). Sometimes that steady light level is nearly impossible (if you are shooting
flats near twilight, for example).

Fortunately, there is a way to compensate by normalizing (or scaling) the images so that they all have the same typical
value. AstroImageJ can do that normalization for you by following these steps:

• Open a sequence if you don’t already have one open.

• Go to the menu Process -> Normalize image/stack...

• In the popup that opens you can set two options:

– Whether to use mean or median as the “typical” pixel value (you almost always want median)

– What you want the final value of the “typical” value to be after processing.

Warning: Normalizing will change the pixel values in the images you have open and there is no way to undo it.
If you make a mistake you need to close the image stack and reopen it from the original files.

Todo
1. If you haven’t yet, normalize the sequence of flat images you have open. Is the average pixel value in the image

roughly the same in each image after normalization? Why isn’t the average pixel value the same as the median
pixel value you set in the normalization dialogue box?

2. Suppose one of the original images had a median pixel value of 23,200 and that you want to have want the
median after normalization to be 2. Describe in detail what you need to do to the image to normalize (detail in
the sense of the math operations you would need to carry out if you were to normalize by hand, not details of
how to do it in AstroImageJ) and explain why your answer is correct.

2.3 Master frames

2.3.1 Overview

Master frame is a combination (stack) of calibration frames of the same type. The preferred method of combination is
median, to eliminate artifacts like cosmic rays, unless you have some good reason for averaging instead.

Note: For this part use the images the folder from the last lab (called float).
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2.3.2 Master Bias

Todo
1. Make a master bias frame using all of the bias frames in the folder and save the result as a FITS image. Make a

note of:

• Which files went into the master.

• How you combined the files.

• How many files went into the master.

• What you called the master bias frame.

Note: When you are done making the master bias, you can close the image sequence.

2.3.3 Master Dark

There are two different ways the term master dark is used; in some ways that is because there are two contributions to
the counts in a dark frame:

Dark counts = bias + thermal electrons (aka dark current)

One version of a master dark contains all of the dark counts, including the bias. The other includes only the contribu-
tion from the thermal electrons.

The first variety is convenient because you can use that single master to remove both bias and thermal electrons from
your images. The second variety is necessary if some of the science images you have do not have the same exposure
as your dark frames because the second variety can be scaled to different exposure times.

Today we will focus on the first variety, master darks that also include the bias.

Dark frames of different exposure time should have different pixel values...which means you should only combine
dark frames that have the same exposure.

Todo
1. Make a master dark. Use all of the files in the float folder that start with twi and have D15 in the name.

Combine using a median, and save the result as a FITS image. Make a note of:

• Which files went into the master.

• How you combined the files.

• What the exposure time was for these darks.

• What you called the master dark frame.

Note: When you are done creating the master dark you can close the image sequence of darks.

2.3.4 Master Flat

Remember that a flat really is an image of something: uniform illumination. Just like an image of something more
interesting (like stars), it needs some basic calibration before it can be used to correct for differences in illumination
in science images.
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We will return to the procedure for finding a master flat in a little bit, after walking through the most basic parts of
image reduction.

2.4 Your first image reduction

As your very first experience with reducing (i.e. calibrating) an image you will calibrate one flat frame from the folder
float.

Open any one of the flat images whose name begins twi and is in the R filter (these have R in the name).

Todo
1. Double-check the exposure time of the flat you opened. Does it match the exposure time of the master dark you

created?

2. Use the image calculator to subtract your master dark from the flat frame that you opened.

3. In principle, the pixel values are now all due to light that fell on the CCD. Pick a pixel, and convert the value
from ADU to photons using the gain you calculated earlier. How many photons was it?

2.5 Questions

Todo
1. For each file name below explain why the name would or would not match the pattern twi-.*bias.*

• Twi-bias.fit

• twi-diffuser-flat-001bias.fit

• twi-diffuser-flat-001bias_flt.fit

• twi-diffuser-flat-001bIas.fit

2. Look at the list of the files in the folder for_gain. For each of the items below come up with a pattern that
matches the right files. Check your patterns by starting to open an image sequence in AstroImageJ, selecting the
folder for_gain, entering the pattern in the right place, and verifying that the correct number of files matches.

(a) All bias images that have “twi” in the name (should be 11 files)

(b) The images in the R band (R is in the file name) that also have “flood” in the name and are number 001
through 003 (should be 3 files).

(c) The images in the I band with “flood” in the name (10 items)

(d) The images in the I band with “flood” in the name whose number is odd (001, 003, etc) (should be 5
images)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/aij_sequences.rst, line 55.)

Todo
1. Write down the names of the images you chose.

2. Select a region and write down its width, height, and x and y position.
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3. Find the average pixel value in that region in each image you have open. Write them down, clearly indiciating
which measure goes with which image.

4. Calculate the difference between the two bias images.

5. Calculate the difference between the two flat images.

6. Measure the standard deviation in the region you chose in each of the two difference images. Write the result
down, clearly indicating which measurement goes with which difference image.

7. Calculate the gain for the CCD using the formula in Howell’s book.

8. Calculate the read noise for the CCD using the formula in Howell’s book.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/gain_calc_detail.rst, line 24.)

Todo
1. Imagine subtracting an image from itself. What should the result be? Use AstroImageJ to subtract an image

from itself. Does the result match your expectaion?

2. Imagine dividing an image by itself. What should the result be? Use AstroImageJ to divide an image by itself.
Does the result match your expectation.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_arithmetic.rst, line 13.)

Todo
1. Where is the origin used for the x and y position? In other words, where in the image is the point (0,0)?

2. What is the position of the center of the image?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_measurements.rst, line 18.)

Todo
1. Measure the mean pixel value and the standard deviation of the pixel value for one of the images you have open.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_measurements.rst, line 37.)

Todo
1. Make a histogram for a single bias image. Note the width of the bias histogram, which is twice the standard

deviation, and the mean.

2. Combine four of the bias images. Do this by:

• clicking on sequence window so that it is on top

• clickking on the AstroImageJ toolbar to make sure the correct menus are displayed

• selecting Z-Project from the Stacks menu in the Image menu (i.e. Image -> Stacks -> Z-Project) and...

• ...choosing appropriate values for the starting and ending image in the sequence, and...

• ...choose average as the method of combining.

• Be sure to write down the name of the combined image.

2.5. Questions 23



ObsAstro Documentation, Release 0.1

3. Make a histogram of the combination of four bias images. Compare the mean and standard deviation of the
distribution for the combined images with the same numbers for the single image.

4. Repeat for 8 bias images; note the mean and standard deviation.

5. Repeat again for all 16 bias images; note the mean and standard deviation.

6. Describe in words:

(a) How the histogram changes as you increase the number of images in the stack.

(b) How the mean changes as you increase the number of images.

(c) How the standard deviation changes as you increase the number of images.

7. For this type of error it can be shown that the amount of noise (i.e. the standard deviation) should be inversing
proportional to the square root of the number of images. Does this seem to be true, at least roughly, for the
histograms you just compared?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/stats_1.rst, line 18.)

Todo
1. Combine four images using median to Z-project the images, and make a histogram of the combined image.

2. Combine 16 images using median to Z-project the images, and make a histogram of the combing image.

3. Does the pattern you observed for the change in noise as you increase the number of images still hold for median
combining?

4. Compare the mean and standard deviation of these histograms with the corresponding mean and standard devia-
tion from the images combined using the average. Which results in less noise, combing by average or combining
by median?

5. Why might you median combine images even though there is slightly less noise if you combine images by
averaging?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/stats_1.rst, line 44.)

Todo
1. What is different about the first image in the sequence? Look near pixel coordinates (1480, 820)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 12.)

Todo
1. Can you see the defect in the image made by averaging the stack? Why?

2. Can you see the defect in the image made by median combining the stack? Why?

3. In which stacked image is the defect more visible, the average or the median?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 26.)

Todo
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1. If you haven’t yet, normalize the sequence of flat images you have open. Is the average pixel value in the image
roughly the same in each image after normalization? Why isn’t the average pixel value the same as the median
pixel value you set in the normalization dialogue box?

2. Suppose one of the original images had a median pixel value of 23,200 and that you want to have want the
median after normalization to be 2. Describe in detail what you need to do to the image to normalize (detail in
the sense of the math operations you would need to carry out if you were to normalize by hand, not details of
how to do it in AstroImageJ) and explain why your answer is correct.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 52.)

Todo
1. Make a master bias frame using all of the bias frames in the folder and save the result as a FITS image. Make a

note of:

• Which files went into the master.

• How you combined the files.

• How many files went into the master.

• What you called the master bias frame.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/masters.rst, line 15.)

Todo
1. Make a master dark. Use all of the files in the float folder that start with twi and have D15 in the name.

Combine using a median, and save the result as a FITS image. Make a note of:

• Which files went into the master.

• How you combined the files.

• What the exposure time was for these darks.

• What you called the master dark frame.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/masters.rst, line 43.)

Todo
1. Double-check the exposure time of the flat you opened. Does it match the exposure time of the master dark you

created?

2. Use the image calculator to subtract your master dark from the flat frame that you opened.

3. In principle, the pixel values are now all due to light that fell on the CCD. Pick a pixel, and convert the value
from ADU to photons using the gain you calculated earlier. How many photons was it?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/reduce_a_flat.rst, line 8.)

Todo
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1. Open up SIMBAD and look up the information on your target. Make note of any other common names for your
target, its position (in J2000 coordinates), and its magnitude (NOTE: You may want to save a bookmark to your
object’s SIMBAD page).

2. Write down a list of the kind of observations you will need to make for your project (NOT INCLUDING the
biases, darks, and flats you would have to shoot for any telescopic observations). Include the number of images
and which filters you will need to use. You should also note if the images need to be in very dark skies or if
you can shoot in brighter (possibly moonlit) skies. WARNING: One part of planning we are not addressing yet
is estimating how long you need to make your exposures. This is critical because it affects how much you can
actually shoot each night. We will be addressing this next week.

3. Edit the my_objects_list.txt text file to include your target(s) as the first object(s) on the list. You can also delete
any lines for objects you do not intend to observe if you wish.

4. Open up jSkyCalc and load the objects list. Set the date in jSkyCalc to the appropriate date. When is sunset and
sunrise for the night you are checking? You may need to know this to plan for twilight flats.

5. When does twilight end (evening) and begin (morning)? You may need these times to plan for twilight flats and
to know when science observing can occur.

6. Set the time in jSkyCalc to twilight for that evening. What is the Hour Angle of your target? What does this
mean?

7. What is the airmass profile for your target? What time of night will your target be high enough for it to be a
good time to observe your object, if any? Clarify how you reached this decision (e.g. - What did you look for to
make this decision?)

8. Is the moon going to be a problem for you on March 1-3?

9. Check the “seasonal observability” and confirm when during the spring semester would be a good time of year
to observe the target. Make note of those times as well as how you reached the decision (e.g. - Did you consider
just airmass or did you also need to consider the phase of the moon?)

10. Lastly, to help with you identifying the target at the telescope, put together a Finder Chart with a 20 arcminute wide field of view with a limit of about 17th magnitude. Use one of the following services:

• SIMBAD or

• the MAPS Catalog Finder Chart service or

• AAVSO Variable Star Plotter service.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/03_planning_observations/checking.rst, line 8.)

Todo
1. What project do you think you would like to attempt?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/03_planning_observations/choosing.rst, line 67.)

Todo
1. Suppose your dark frames were exposed for 30 seconds but your science images were 90 second exposures.

Explain how you would need to adjust the dark current images to use them for removing dark current from your
science image.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduce_science_overview.rst, line 44.)
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Todo
1. If for some reason you wanted to could you still, even in case 2, do the data reduction the way it is in case 1?

Explain.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduce_science_overview.rst, line 59.)

Todo
1. Examine the FITS headers of the images. Which of the two data reduction cases in the previous discussion

applies here? Explain.

2. Reduce the science image.

(a) First, subtract of the bias/dark current or the dark frame (depending on which case applies here). Identify
one or more features of the image that visibly changed when you did this step of the calibration.

(b) Second, use the flat field to correct the illumination. Describe what changes, if any you see in the image.
Hint: As with the previous step, you will need to use the image calculator.

3. Summarize, in your own words, the steps needed to reduce a science image.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduction_by_hand.rst, line 6.)

Todo
1. As a refresher, write down the three basic types of calibration you do to images.

2. Open one of the science images you have been asked to reduce.

3. Based on the exposure time and filter of the image, what calibration files will you need?

4. Are there additional calibration images you need to calibrate the calibration images in the previous question? If
yes, what are they?

5. Are there calibration images you need that do not depend on exposure time or filter? What are they?

You should end this section of questions with a clear list of the calibration images you will need (e.g. flats in the Z
filter, darks with an exposure time of 120 hours).

Check your list with any one of the instructors before you move on.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/automated_reduction.rst, line 53.)

Todo
1. How many bias frames should be included by the this automated tool? Note: there is no fancy way to figure this

out. Look at the file names.

2. Does the master bias image that you produced look like a master bias should? By this point you should have
some rough idea of what a master bias looks like and you should have notes on what the typical pixel value is in
a bias frame. Check both of those things.

3. Compare your master bias image to the appropriate reference_images to make sure they are really the same. Do
that by loading both your master bias and ours and using AstroImageJ to take the difference or the ratio (what
would you expect for either?).
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(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_bias.rst, line 25.)

Todo
1. Review the list of calibration files you made in Get organized before you get going. How many master dark

images will you need to make?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_dark.rst, line 4.)

Todo
1. How many dark frames should be included by the this automated tool for each of the master darks you need to

create? Note: there is no fancy way to figure this out. Look at the file names.

2. Does the master dark image(s) that you produced look like a master dark should? By this point you should have
some rough idea of what a master dark looks like and you should have notes on what the typical pixel value is
in a dark frame. Check both of those things.

3. Compare your master dark image(s) to the appropriate reference_images to make sure they are really the same.
Do that by loading both your master dark(s) and ours and using AstroImageJ to take the difference or the ratio
(what would you expect for either?).

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_dark.rst, line 32.)

Todo
1. Review the list of calibration files you made in Get organized before you get going. How many master flat

images will you need to make? What filter(s)?

2. What calibration frames will you need to make your master flat?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_flat.rst, line 6.)

Todo
1. How many flat frames should be included by the this automated tool for each of the master flats you need to

create? Note: there is no fancy way to figure this out. Look at the file names.

2. Does the master flat image(s) that you produced look like a master flat should? By this point you should have
some rough idea of what a master flat looks like and you should have notes on what the typical pixel value is in
a flat frame. Check both of those things.

3. Compare your master flat image(s) to the appropriate reference_images to make sure they are really the same. Do that by loading both your master flat(s) and ours and using AstroImageJ to take the difference.

• NOTE: If there turn out to be tiny differences, they may appear to be more significant than they are
when displayed, since AstroImageJ scales the image to the range of values in the image. A better test
might be taking the RATIO of your flat versus the reference flat image if your flat and our reference
flat are just offset from each other by a tiny but constant fraction.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_flat.rst, line 31.)
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Todo
1. How many science frames should be included by the this automated tool? Note: there is no fancy way to figure

this out. Look at the file names.

2. Does the calibrated science image look sensible? By now you should be able to recognize if there are obvious
defects (e.g. dust donuts)

3. Compare your science image(s) to the appropriate reference_images to make sure they are really the same.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/reduce.rst, line 30.)

Todo
1. If you choose 𝐶 = 0, what is the instrumental magnitude for the star you measured?

2. Look at the table of magnitudes handed out (also available here). Does your instrumental magnitude match the
V magnitude of the star you chose? Should it?

3. What would you have to choose C to be for your magnitude to match the magnitude in the table?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/instrumental_mags_and_the_beauty_of_photometry.rst, line 24.)

Todo
1. Talk to someone who chose a different star than you did and calculate the difference in instrumental magnitude

between your two stars.

2. Compare your difference in instrumental magnitude to the difference in the reported magnitudes of the two stars
in the table.

3. Try looking up your two stars in simbad and write down their V magnitudes according to simbad.

• do a coordinate search

• one format for entering coordinates is like: 2.703738h+42.77795d

• RA is first, in decimal hours, followed by declination in decimal degrees

4. Does the magnitude difference as calculated from simbad match what you get from the table we provided? Does
it match your image?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/instrumental_mags_and_the_beauty_of_photometry.rst, line 48.)

Todo
1. What is the FWHM of the star you took the seeing profile of?

2. What does the FWHM mean? Answer both in terms of what the acronym means and an explanation in plain
english what it represents.

3. What aperture size was chosen? How large is it compared to the FWHM (e.g. 2X, or half)?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/photometry_aij.rst, line 21.)

Todo
1. Write down, from the measurement table, for the star you chose:
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• the RA and Dec (in decimal hours and decimal degrees)

• net counts (Source-Sky)

• source radius

• minimum and maximum sky radius

• Sky counts/pixel

• Source Error

• Source SNR

2. What was the net number of photons received from the star in the aperture? Hint: Don’t forget about the gain.

3. Pay attention to the folks up front for a brief lecture about error and signal-to-noise ratio (SNR). Take useful
notes.

4. Calculate the source error and SNR and compare to the values of each from AstroImageJ

5. What is the largest source of error?

6. Of the “noise” terms (dark, sky, read noise), which makes the largest contribution?

7. How could you reduce that source of noise?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/photometry_aij.rst, line 48.)

Todo
1. Add three columns to your data table, one for the instrumental magnitudes of each of the three stars for which

you have photometry. NOTE: AstroImageJ calls the columns that contain the net counts (i.e. 𝑁Source − 𝑁Sky)
something like Source-Sky_T1 or Source-Sky_T2. Use a value of zero for C.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 17.)

Todo
1. Make a graph with airmass on the horizontal axis and instrumental magnitude on the vertical axis, like BGO

Fig. 7.4. Use the “target” star.

• Display the points as points not a line like the book does.

• Excel will pick stupid default values for the airmass values; be sure to at least change the minimum value
to something sensible.

2. Add a trendline to each of the data series. In the options for the trend line:

• Display the fit equation

• Display 𝑅2

3. What would the instrumental magnitude of this star be if corrected for the atmosphere? Hint: What does 𝑚0

represent, physically (mathematically it is the y-intercept of the line you fit to the data)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 35.)

Todo
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1. Add the instrumental magnitudes of the other two stars to your graph. The graph should have three sets of points
on it, one set for each of the three stars (i.e. three data series, in Excel-speak).

2. Add trendlines to the new data series.

3. Do all three stars experience the same extinction coefficient, k? Why do you think that is?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 59.)

Todo
1. Open the image “reference-positions.fit” to get the RA and Dec for each of the stars you look at and write them

down in your notebook.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/multi_aperture_photometry.rst, line 36.)

Todo
1. Write down the FWHM, aperture size, inner sky radius and outer sky radius you chose.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/set_aperture_radius.rst, line 22.)

Todo
1. For my project to succeed, what do I need to actually accurately measure from my science images?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/data_processing_questions.rst, line 6.)

Todo
1. Calibrated Astrometry: Do I need to know where my objects actually are in the sky? Do I need to be concerned

with their motion? Note: None of your projects this year involved tracking moving objects, so this is not critical.
That said, it is a good idea to calibrate your astrometry so that you know where each point in your image actually
is in the sky. Luckily for you, we have already calibrated all your images astrometrically using a software
package called astrometry.net.

2. Calibrated Photometry: Do you need to calibrate your photometry so that it can be compared to others?
That is, do you need to report calibrated magnitudes or can you stick to instrumental magnitudes? If you need
calibrated magnitudes, how would you go about getting them? What standard stars will you use?

3. Atmospheric Extinction Corrections: Do you need to be concerned with determining the extinction and red-
dening per airmass for your target? If so, how could you determine it?

4. Galactic Extinction Corrections: Do you need to be concerned with determining the amount of Galactic
extinction or reddening to your target? Why or why not?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/data_processing_questions.rst, line 11.)

Todo
1. Do you need to stack images in order to bring out faint features in your images? If so, what images do you need

to stack to produce what final images. How will you make sure the stacked images are aligned?
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• If you are stacking science images you will need to align them first. Instructions for aligning are at
http://physics.mnstate.edu/craig/astro_project/align.html#align-the-images

• If you need them, instructions for stacking are at http://physics.mnstate.edu/craig/image_stats/stats_1.html#different-
ways-of-combining-average-vs-median

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/image_processing_questions.rst, line 6.)

Todo
1. For my project to succeed, what do I need to actually accurately measure from my science images?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/introduction.rst, line 25.)
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CHAPTER 3

Planning Observations for your Observing Project

Contents:

3.1 Before you begin

• Open a browser window to SIMBAD at http://simbad.u-strasbg.fr/simbad/

• Download JSkyCalc.zip from D2L and unpack the contents to work with as you did in the last lecture on Tuesday.

• Open JSkyCalc.jar for use later. If you are running this on your own computer, you may have to install Java
Runtime Environment first before trying to open the jar file.

3.2 Choosing a Project

• Drs. Cabanela and Craig should have described the projects that are available to do. As a reminder, here is a list of observing projects requiring new observations at the telescope:

– Variable Star observations (You will need to pick specific star). It may be useful to use the AAVSO
Variable Star Plotter to identify the star in the field.

* EY UMa has a period measured by Hollee Johnson; one more night of good data would be really
helpful.

* HR 7308 has an interesting history as the classical Cepheid with the shortest measured period
(only 1.490808 days, measured by Cabanela 1991) and one of only two known classical Cepheid
variables whose amplitude of variability changes over time in a way that is not just “overtone
beating” (the other Cepheid with this behavior is Polaris). Cabanela has data from 20 years ago
on this star, it would be interesting to see if this star is still varying with a period of 1.490808 days.
The only issue is the star is in Lyrae and not necessarily well positioned for Spring observations.

* EL Dra is listed as an RR Lyrae but has no reported period.

* FK Peg has no reported period; must be checked in the Catalina Sky Survey to see if data is
available indicating that it is not variable.

* EN Cep has a partially measured light curve with data in the AAVSO database. Additional well-
planned observations could refine the estimated period.

* BU Cam has a measured period, but a few well-planned nights could measure the period with
much higher precision.
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– Construction of a Color-Magnitude diagram (for example, V vs. V-R) for a globular or open star cluster. Some possible candidates (not terribly well vetted) include:

* NGC 1039 (Open Star Cluster): Fits on CCD frame, have data on disk already.

* NGC 1912 (Open Star Cluster): Will barely fit on CCD frame, so may have trouble finding
other stars in the field to use for photometric calibration.

* NGC 1960 (Open Star Cluster): Nice diffuse stellar distribution.

* NGC 2099 (Open Star Cluster): Does not quite fit on CCD frame, so may have trouble finding
other stars in the field to use for photometric calibration.

* NGC 2323 (Open Star Cluster): Will barely fit on CCD frame, so may have trouble finding
other stars in the field to use for photometric calibration.

* NGC 4147 (Globular Cluster): Very small on sky, may be very hard to distringuish stars.

* NGC 5024 (Globular Cluster):

* NGC 5053 (Globular Cluster): Somewhat sparse so may be easier to distinguish stars.

* NGC 5272 (Globular Cluster): Will barely fit on CCD frame, so may have trouble finding
other stars in the field to use for photometric calibration.

* NGC 5466 (Globular Cluster): Somewhat sparse so may be easier to distinguish stars.

* NGC 5904 (Globular Cluster): Does not quite fit on CCD frame, so may have trouble finding
other stars in the field to use for photometric calibration.

* NGC 6205 (Globular Cluster): Does not quite fit on CCD frame, so may have trouble finding
other stars in the field to use for photometric calibration.

* NGC 6341 (Globular Cluster): Very dense cluster, may be hard to separate stars.

– Verify that the radial light profile of an elliptical galaxy exhibits a de Vaucouleurs profile (a special case of the Sersic profile). This would require you developing some techniques for analyzing the radial light profile of a galaxy. Some ellipticals you may want to consider looking at:

* NGC 2300: This elliptical galaxy is in an interacting system, so its profile may be distorted.

* NGC 2256: Has a prominent foreground star on top of it.

* NGC 2340: In a group of galaxies.

* UGC 3021: Has some prominent foreground ojbects nearby.

* You can also use “Criteria query” in SIMBAD to find other candidates if you want. HINTS
FOR SIMBAD SEARCH: A good galaxy morphological type (SIMBAD calls it “mttype”) to
search for would be “E0” or “E1”, so that the eliptical is viewed almost face on. You probably
want to find galaxies with a major axis (“dimmajor”) between 10 and 20 arcminutes. Use
jSkyCalc to figure out a reasonable RA range for Spring (about same as the Local Sidereal
Time at Feder in the Spring) and remember SIMBAD expects RA in searches like this to be in
decimal degrees, not hours. Remember that Dec<0 degrees will be far from Zenith and have
limited time at low airmass.

– Verify that the radial light profile of the disk in a spiral galaxy exhibits an exponential profile (a special case of the Sersic profile). This would require you developing some techniques for analyzing the radial light profile of a galaxy. Some spirals you may want to consider looking at:

* NGC 2336: Smaller galaxy with prominent arms, but closer to face on than other galaxies.

* UGC 2885:

* NGC 2903: This galaxy is large enough, but has prominent spiral arms which may distort the
profile.

34 Chapter 3. Planning Observations for your Observing Project

http://en.wikipedia.org/wiki/De_Vaucouleurs%27_law
http://en.wikipedia.org/wiki/Sersic%27s_law
http://simbad.cfa.harvard.edu/simbad/sim-fsam
http://en.wikipedia.org/wiki/Sersic%27s_law


ObsAstro Documentation, Release 0.1

* NGC 2403: This galaxy has an “Active Galactic Nucleus” which may distort the profile in the
center.

* IC 342: Faint disk, but should be manageable with Feder.

* You can also use “Criteria query” in SIMBAD to find other candidates if you want. HINTS
FOR SIMBAD SEARCH: A good galaxy (“otype” is “G”) would have morphological type
(“mttype”) to search for would be “S”. You probably want to find galaxies with a major axis
(“dimmajor”) between 5 and 20 arcminutes. Use jSkyCalc to figure out a reasonable RA range
for Spring (about same as the Local Sidereal Time at Feder in the Spring) and remember SIM-
BAD expects RA in searches like this to be in decimal degrees, not hours. Remember that
Dec<0 degrees will be far from Zenith and have limited time at low airmass.

– Try to detect the transit of a known exoplanet. This would require you to do some work to identify
candidate exoplanets. The Exoplanet Transit Database will produce a list of predicted transits for any
date, given the latitude and longitude of our observatory.

– Try to measure the light profile of an eclipsing binary system and use this to determine the orbital
parameters for the two stars. This would require you to research eclipsing binaries a bit and identifying
a star with an upcoming eclipse. You may find this list of Eclipsing Binary Ephemerides from the
AAVSO useful.

– Measuring the variation in color and magnitude of a star with increasing airmass at the Feder obser-
vatory. This would best be done using known Landolt standard stars with established fluxes. See
Landolt 1992 and Landolt 2009 .

• There are also possible projects that would not require new observations, but rather analysis of existing data. These might be good alternatives if the weather doesn’t hold up this semester. These “no new observations” required projects include:

– Creation of master frames for each night for which there is useful calibration data. And identification
of nights for which some or all calibration data is missing.

– Check of stability of bias pattern and level over time and camera temperature.

– Cross check of dome flats, diffuser twilight flats and regular twilight flats.

– HT Vul (We already have a few nights of good data. The period falls in an interesting timescale, about
0.15 days, long for a delta Scuti star, short for RR Lyrae, might be SX Phoenecius).

– EE Lyn (hard, will require stacking before photometry, several nights).

Todo
1. What project do you think you would like to attempt?

3.3 Checking the “Mechanical” and “Scientific” Viability of your
Project

We start the planning process by planning out the observations we will need for our project. Once we have determined
the “scientific” viability of making the observations we need, then you will need to check the “mechanical” viability
of making your observations from a given location and at a given time.

For this activity, assume you will be doing this project the weekend after next (March 1 - 3, 2013) at the Feder
Observatory.

Todo
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1. Open up SIMBAD and look up the information on your target. Make note of any other common names for your
target, its position (in J2000 coordinates), and its magnitude (NOTE: You may want to save a bookmark to your
object’s SIMBAD page).

2. Write down a list of the kind of observations you will need to make for your project (NOT INCLUDING the
biases, darks, and flats you would have to shoot for any telescopic observations). Include the number of images
and which filters you will need to use. You should also note if the images need to be in very dark skies or if
you can shoot in brighter (possibly moonlit) skies. WARNING: One part of planning we are not addressing yet
is estimating how long you need to make your exposures. This is critical because it affects how much you can
actually shoot each night. We will be addressing this next week.

3. Edit the my_objects_list.txt text file to include your target(s) as the first object(s) on the list. You can also delete
any lines for objects you do not intend to observe if you wish.

4. Open up jSkyCalc and load the objects list. Set the date in jSkyCalc to the appropriate date. When is sunset and
sunrise for the night you are checking? You may need to know this to plan for twilight flats.

5. When does twilight end (evening) and begin (morning)? You may need these times to plan for twilight flats and
to know when science observing can occur.

6. Set the time in jSkyCalc to twilight for that evening. What is the Hour Angle of your target? What does this
mean?

7. What is the airmass profile for your target? What time of night will your target be high enough for it to be a
good time to observe your object, if any? Clarify how you reached this decision (e.g. - What did you look for to
make this decision?)

8. Is the moon going to be a problem for you on March 1-3?

9. Check the “seasonal observability” and confirm when during the spring semester would be a good time of year
to observe the target. Make note of those times as well as how you reached the decision (e.g. - Did you consider
just airmass or did you also need to consider the phase of the moon?)

10. Lastly, to help with you identifying the target at the telescope, put together a Finder Chart with a 20 arcminute wide field of view with a limit of about 17th magnitude. Use one of the following services:

• SIMBAD or

• the MAPS Catalog Finder Chart service or

• AAVSO Variable Star Plotter service.

3.4 List of All Questions

Todo
1. For each file name below explain why the name would or would not match the pattern twi-.*bias.*

• Twi-bias.fit

• twi-diffuser-flat-001bias.fit

• twi-diffuser-flat-001bias_flt.fit

• twi-diffuser-flat-001bIas.fit

2. Look at the list of the files in the folder for_gain. For each of the items below come up with a pattern that
matches the right files. Check your patterns by starting to open an image sequence in AstroImageJ, selecting the
folder for_gain, entering the pattern in the right place, and verifying that the correct number of files matches.

(a) All bias images that have “twi” in the name (should be 11 files)
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(b) The images in the R band (R is in the file name) that also have “flood” in the name and are number 001
through 003 (should be 3 files).

(c) The images in the I band with “flood” in the name (10 items)

(d) The images in the I band with “flood” in the name whose number is odd (001, 003, etc) (should be 5
images)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/aij_sequences.rst, line 55.)

Todo
1. Write down the names of the images you chose.

2. Select a region and write down its width, height, and x and y position.

3. Find the average pixel value in that region in each image you have open. Write them down, clearly indiciating
which measure goes with which image.

4. Calculate the difference between the two bias images.

5. Calculate the difference between the two flat images.

6. Measure the standard deviation in the region you chose in each of the two difference images. Write the result
down, clearly indicating which measurement goes with which difference image.

7. Calculate the gain for the CCD using the formula in Howell’s book.

8. Calculate the read noise for the CCD using the formula in Howell’s book.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/gain_calc_detail.rst, line 24.)

Todo
1. Imagine subtracting an image from itself. What should the result be? Use AstroImageJ to subtract an image

from itself. Does the result match your expectaion?

2. Imagine dividing an image by itself. What should the result be? Use AstroImageJ to divide an image by itself.
Does the result match your expectation.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_arithmetic.rst, line 13.)

Todo
1. Where is the origin used for the x and y position? In other words, where in the image is the point (0,0)?

2. What is the position of the center of the image?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_measurements.rst, line 18.)

Todo
1. Measure the mean pixel value and the standard deviation of the pixel value for one of the images you have open.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_measurements.rst, line 37.)
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Todo
1. Make a histogram for a single bias image. Note the width of the bias histogram, which is twice the standard

deviation, and the mean.

2. Combine four of the bias images. Do this by:

• clicking on sequence window so that it is on top

• clickking on the AstroImageJ toolbar to make sure the correct menus are displayed

• selecting Z-Project from the Stacks menu in the Image menu (i.e. Image -> Stacks -> Z-Project) and...

• ...choosing appropriate values for the starting and ending image in the sequence, and...

• ...choose average as the method of combining.

• Be sure to write down the name of the combined image.

3. Make a histogram of the combination of four bias images. Compare the mean and standard deviation of the
distribution for the combined images with the same numbers for the single image.

4. Repeat for 8 bias images; note the mean and standard deviation.

5. Repeat again for all 16 bias images; note the mean and standard deviation.

6. Describe in words:

(a) How the histogram changes as you increase the number of images in the stack.

(b) How the mean changes as you increase the number of images.

(c) How the standard deviation changes as you increase the number of images.

7. For this type of error it can be shown that the amount of noise (i.e. the standard deviation) should be inversing
proportional to the square root of the number of images. Does this seem to be true, at least roughly, for the
histograms you just compared?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/stats_1.rst, line 18.)

Todo
1. Combine four images using median to Z-project the images, and make a histogram of the combined image.

2. Combine 16 images using median to Z-project the images, and make a histogram of the combing image.

3. Does the pattern you observed for the change in noise as you increase the number of images still hold for median
combining?

4. Compare the mean and standard deviation of these histograms with the corresponding mean and standard devia-
tion from the images combined using the average. Which results in less noise, combing by average or combining
by median?

5. Why might you median combine images even though there is slightly less noise if you combine images by
averaging?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/stats_1.rst, line 44.)

Todo
1. What is different about the first image in the sequence? Look near pixel coordinates (1480, 820)
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(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 12.)

Todo
1. Can you see the defect in the image made by averaging the stack? Why?

2. Can you see the defect in the image made by median combining the stack? Why?

3. In which stacked image is the defect more visible, the average or the median?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 26.)

Todo
1. If you haven’t yet, normalize the sequence of flat images you have open. Is the average pixel value in the image

roughly the same in each image after normalization? Why isn’t the average pixel value the same as the median
pixel value you set in the normalization dialogue box?

2. Suppose one of the original images had a median pixel value of 23,200 and that you want to have want the
median after normalization to be 2. Describe in detail what you need to do to the image to normalize (detail in
the sense of the math operations you would need to carry out if you were to normalize by hand, not details of
how to do it in AstroImageJ) and explain why your answer is correct.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 52.)

Todo
1. Make a master bias frame using all of the bias frames in the folder and save the result as a FITS image. Make a

note of:

• Which files went into the master.

• How you combined the files.

• How many files went into the master.

• What you called the master bias frame.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/masters.rst, line 15.)

Todo
1. Make a master dark. Use all of the files in the float folder that start with twi and have D15 in the name.

Combine using a median, and save the result as a FITS image. Make a note of:

• Which files went into the master.

• How you combined the files.

• What the exposure time was for these darks.

• What you called the master dark frame.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/masters.rst, line 43.)
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Todo
1. Double-check the exposure time of the flat you opened. Does it match the exposure time of the master dark you

created?

2. Use the image calculator to subtract your master dark from the flat frame that you opened.

3. In principle, the pixel values are now all due to light that fell on the CCD. Pick a pixel, and convert the value
from ADU to photons using the gain you calculated earlier. How many photons was it?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/reduce_a_flat.rst, line 8.)

Todo
1. Open up SIMBAD and look up the information on your target. Make note of any other common names for your

target, its position (in J2000 coordinates), and its magnitude (NOTE: You may want to save a bookmark to your
object’s SIMBAD page).

2. Write down a list of the kind of observations you will need to make for your project (NOT INCLUDING the
biases, darks, and flats you would have to shoot for any telescopic observations). Include the number of images
and which filters you will need to use. You should also note if the images need to be in very dark skies or if
you can shoot in brighter (possibly moonlit) skies. WARNING: One part of planning we are not addressing yet
is estimating how long you need to make your exposures. This is critical because it affects how much you can
actually shoot each night. We will be addressing this next week.

3. Edit the my_objects_list.txt text file to include your target(s) as the first object(s) on the list. You can also delete
any lines for objects you do not intend to observe if you wish.

4. Open up jSkyCalc and load the objects list. Set the date in jSkyCalc to the appropriate date. When is sunset and
sunrise for the night you are checking? You may need to know this to plan for twilight flats.

5. When does twilight end (evening) and begin (morning)? You may need these times to plan for twilight flats and
to know when science observing can occur.

6. Set the time in jSkyCalc to twilight for that evening. What is the Hour Angle of your target? What does this
mean?

7. What is the airmass profile for your target? What time of night will your target be high enough for it to be a
good time to observe your object, if any? Clarify how you reached this decision (e.g. - What did you look for to
make this decision?)

8. Is the moon going to be a problem for you on March 1-3?

9. Check the “seasonal observability” and confirm when during the spring semester would be a good time of year
to observe the target. Make note of those times as well as how you reached the decision (e.g. - Did you consider
just airmass or did you also need to consider the phase of the moon?)

10. Lastly, to help with you identifying the target at the telescope, put together a Finder Chart with a 20 arcminute wide field of view with a limit of about 17th magnitude. Use one of the following services:

• SIMBAD or

• the MAPS Catalog Finder Chart service or

• AAVSO Variable Star Plotter service.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/03_planning_observations/checking.rst, line 8.)

Todo
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1. What project do you think you would like to attempt?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/03_planning_observations/choosing.rst, line 67.)

Todo
1. Suppose your dark frames were exposed for 30 seconds but your science images were 90 second exposures.

Explain how you would need to adjust the dark current images to use them for removing dark current from your
science image.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduce_science_overview.rst, line 44.)

Todo
1. If for some reason you wanted to could you still, even in case 2, do the data reduction the way it is in case 1?

Explain.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduce_science_overview.rst, line 59.)

Todo
1. Examine the FITS headers of the images. Which of the two data reduction cases in the previous discussion

applies here? Explain.

2. Reduce the science image.

(a) First, subtract of the bias/dark current or the dark frame (depending on which case applies here). Identify
one or more features of the image that visibly changed when you did this step of the calibration.

(b) Second, use the flat field to correct the illumination. Describe what changes, if any you see in the image.
Hint: As with the previous step, you will need to use the image calculator.

3. Summarize, in your own words, the steps needed to reduce a science image.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduction_by_hand.rst, line 6.)

Todo
1. As a refresher, write down the three basic types of calibration you do to images.

2. Open one of the science images you have been asked to reduce.

3. Based on the exposure time and filter of the image, what calibration files will you need?

4. Are there additional calibration images you need to calibrate the calibration images in the previous question? If
yes, what are they?

5. Are there calibration images you need that do not depend on exposure time or filter? What are they?

You should end this section of questions with a clear list of the calibration images you will need (e.g. flats in the Z
filter, darks with an exposure time of 120 hours).

Check your list with any one of the instructors before you move on.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/automated_reduction.rst, line 53.)
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Todo
1. How many bias frames should be included by the this automated tool? Note: there is no fancy way to figure this

out. Look at the file names.

2. Does the master bias image that you produced look like a master bias should? By this point you should have
some rough idea of what a master bias looks like and you should have notes on what the typical pixel value is in
a bias frame. Check both of those things.

3. Compare your master bias image to the appropriate reference_images to make sure they are really the same. Do
that by loading both your master bias and ours and using AstroImageJ to take the difference or the ratio (what
would you expect for either?).

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_bias.rst, line 25.)

Todo
1. Review the list of calibration files you made in Get organized before you get going. How many master dark

images will you need to make?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_dark.rst, line 4.)

Todo
1. How many dark frames should be included by the this automated tool for each of the master darks you need to

create? Note: there is no fancy way to figure this out. Look at the file names.

2. Does the master dark image(s) that you produced look like a master dark should? By this point you should have
some rough idea of what a master dark looks like and you should have notes on what the typical pixel value is
in a dark frame. Check both of those things.

3. Compare your master dark image(s) to the appropriate reference_images to make sure they are really the same.
Do that by loading both your master dark(s) and ours and using AstroImageJ to take the difference or the ratio
(what would you expect for either?).

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_dark.rst, line 32.)

Todo
1. Review the list of calibration files you made in Get organized before you get going. How many master flat

images will you need to make? What filter(s)?

2. What calibration frames will you need to make your master flat?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_flat.rst, line 6.)

Todo
1. How many flat frames should be included by the this automated tool for each of the master flats you need to

create? Note: there is no fancy way to figure this out. Look at the file names.

2. Does the master flat image(s) that you produced look like a master flat should? By this point you should have
some rough idea of what a master flat looks like and you should have notes on what the typical pixel value is in
a flat frame. Check both of those things.
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3. Compare your master flat image(s) to the appropriate reference_images to make sure they are really the same. Do that by loading both your master flat(s) and ours and using AstroImageJ to take the difference.

• NOTE: If there turn out to be tiny differences, they may appear to be more significant than they are
when displayed, since AstroImageJ scales the image to the range of values in the image. A better test
might be taking the RATIO of your flat versus the reference flat image if your flat and our reference
flat are just offset from each other by a tiny but constant fraction.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_flat.rst, line 31.)

Todo
1. How many science frames should be included by the this automated tool? Note: there is no fancy way to figure

this out. Look at the file names.

2. Does the calibrated science image look sensible? By now you should be able to recognize if there are obvious
defects (e.g. dust donuts)

3. Compare your science image(s) to the appropriate reference_images to make sure they are really the same.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/reduce.rst, line 30.)

Todo
1. If you choose 𝐶 = 0, what is the instrumental magnitude for the star you measured?

2. Look at the table of magnitudes handed out (also available here). Does your instrumental magnitude match the
V magnitude of the star you chose? Should it?

3. What would you have to choose C to be for your magnitude to match the magnitude in the table?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/instrumental_mags_and_the_beauty_of_photometry.rst, line 24.)

Todo
1. Talk to someone who chose a different star than you did and calculate the difference in instrumental magnitude

between your two stars.

2. Compare your difference in instrumental magnitude to the difference in the reported magnitudes of the two stars
in the table.

3. Try looking up your two stars in simbad and write down their V magnitudes according to simbad.

• do a coordinate search

• one format for entering coordinates is like: 2.703738h+42.77795d

• RA is first, in decimal hours, followed by declination in decimal degrees

4. Does the magnitude difference as calculated from simbad match what you get from the table we provided? Does
it match your image?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/instrumental_mags_and_the_beauty_of_photometry.rst, line 48.)

Todo
1. What is the FWHM of the star you took the seeing profile of?
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2. What does the FWHM mean? Answer both in terms of what the acronym means and an explanation in plain
english what it represents.

3. What aperture size was chosen? How large is it compared to the FWHM (e.g. 2X, or half)?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/photometry_aij.rst, line 21.)

Todo
1. Write down, from the measurement table, for the star you chose:

• the RA and Dec (in decimal hours and decimal degrees)

• net counts (Source-Sky)

• source radius

• minimum and maximum sky radius

• Sky counts/pixel

• Source Error

• Source SNR

2. What was the net number of photons received from the star in the aperture? Hint: Don’t forget about the gain.

3. Pay attention to the folks up front for a brief lecture about error and signal-to-noise ratio (SNR). Take useful
notes.

4. Calculate the source error and SNR and compare to the values of each from AstroImageJ

5. What is the largest source of error?

6. Of the “noise” terms (dark, sky, read noise), which makes the largest contribution?

7. How could you reduce that source of noise?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/photometry_aij.rst, line 48.)

Todo
1. Add three columns to your data table, one for the instrumental magnitudes of each of the three stars for which

you have photometry. NOTE: AstroImageJ calls the columns that contain the net counts (i.e. 𝑁Source − 𝑁Sky)
something like Source-Sky_T1 or Source-Sky_T2. Use a value of zero for C.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 17.)

Todo
1. Make a graph with airmass on the horizontal axis and instrumental magnitude on the vertical axis, like BGO

Fig. 7.4. Use the “target” star.

• Display the points as points not a line like the book does.

• Excel will pick stupid default values for the airmass values; be sure to at least change the minimum value
to something sensible.

2. Add a trendline to each of the data series. In the options for the trend line:

• Display the fit equation
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• Display 𝑅2

3. What would the instrumental magnitude of this star be if corrected for the atmosphere? Hint: What does 𝑚0

represent, physically (mathematically it is the y-intercept of the line you fit to the data)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 35.)

Todo
1. Add the instrumental magnitudes of the other two stars to your graph. The graph should have three sets of points

on it, one set for each of the three stars (i.e. three data series, in Excel-speak).

2. Add trendlines to the new data series.

3. Do all three stars experience the same extinction coefficient, k? Why do you think that is?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 59.)

Todo
1. Open the image “reference-positions.fit” to get the RA and Dec for each of the stars you look at and write them

down in your notebook.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/multi_aperture_photometry.rst, line 36.)

Todo
1. Write down the FWHM, aperture size, inner sky radius and outer sky radius you chose.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/set_aperture_radius.rst, line 22.)

Todo
1. For my project to succeed, what do I need to actually accurately measure from my science images?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/data_processing_questions.rst, line 6.)

Todo
1. Calibrated Astrometry: Do I need to know where my objects actually are in the sky? Do I need to be concerned

with their motion? Note: None of your projects this year involved tracking moving objects, so this is not critical.
That said, it is a good idea to calibrate your astrometry so that you know where each point in your image actually
is in the sky. Luckily for you, we have already calibrated all your images astrometrically using a software
package called astrometry.net.

2. Calibrated Photometry: Do you need to calibrate your photometry so that it can be compared to others?
That is, do you need to report calibrated magnitudes or can you stick to instrumental magnitudes? If you need
calibrated magnitudes, how would you go about getting them? What standard stars will you use?

3. Atmospheric Extinction Corrections: Do you need to be concerned with determining the extinction and red-
dening per airmass for your target? If so, how could you determine it?

4. Galactic Extinction Corrections: Do you need to be concerned with determining the amount of Galactic
extinction or reddening to your target? Why or why not?
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(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/data_processing_questions.rst, line 11.)

Todo
1. Do you need to stack images in order to bring out faint features in your images? If so, what images do you need

to stack to produce what final images. How will you make sure the stacked images are aligned?

• If you are stacking science images you will need to align them first. Instructions for aligning are at
http://physics.mnstate.edu/craig/astro_project/align.html#align-the-images

• If you need them, instructions for stacking are at http://physics.mnstate.edu/craig/image_stats/stats_1.html#different-
ways-of-combining-average-vs-median

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/image_processing_questions.rst, line 6.)

Todo
1. For my project to succeed, what do I need to actually accurately measure from my science images?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/introduction.rst, line 25.)
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CHAPTER 4

Image reduction by hand

Note: You should not carry out your reductions this way for large projects. This introduction has you carry out several
steps manually that are better done automatically.

4.1 Before you begin

• Download the zip file at http://physics.mnstate.edu/craig/reduce-by-hand.zip and unzip it.

4.2 Reduction of a science image: overview

4.2.1 Some Vocabulary

A science image is an image from which you hope to measure something; in other words it an image that is not a bias
or a dark or a flat.

The term reduction means calibration of a an image to compensate for the effects of bias level, dark current and
non-uniform illumination of the CCD.

We will make a distinction between a dark frame, which is the raw image that comes from the telescope when you ask
it to shoot a dark, and a dark current image, which is a dark frame with the bias removed. This language isn’t standard.
Typically people simply use the word “dark” to refer to both even though they are different things.

4.2.2 Reduction: the concept

In practice this calibration takes two forms depending on the way you choose to compensate for the effects of dark
current. In one form you compensate for dark current and bias in one step; in the other compensating for dark and bias
is two separate steps.

Which way you go depends on the answer to one question: Are your dark frames the same exposure time as your your
science images?

If the answer is you have the option of compensating for dark current and bias in one step; if the answer is no you have
to separate the steps.
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4.2.3 Reduction steps

Case 1: dark and science images have different exposure times

In an equation-like form image reduction looks like this:

science𝑟𝑒𝑑𝑢𝑐𝑒𝑑 =
science𝑟𝑎𝑤 − master bias − dark current𝑠𝑐𝑎𝑙𝑒𝑑

master flat𝑟𝑒𝑑𝑢𝑐𝑒𝑑, 𝑛𝑜𝑟𝑚𝑎𝑙𝑖𝑧𝑒𝑑

Note there is a lot of work buried in here, much of which you have learned how to do in previous labs:

• Create a master bias from your bias frames for the night.

• Create a master dark current image by removing the bias from several dark frames and combining those bias-
subtracted frames.

• Scale the dark current image to match the science image exposure time.

• Create a master flat by calibrating several flat images using the master bias and dark, normalizing the images
and combining those to make a master image.

Once you have done all of those things, reducing the science image is straightforward. You use the image calculator
in AstroImageJ to subtract bias and dark current from the raw science image, then divide by a normalized master flat.

Todo
1. Suppose your dark frames were exposed for 30 seconds but your science images were 90 second exposures.

Explain how you would need to adjust the dark current images to use them for removing dark current from your
science image.

Case 2: dark and science images have the same exposure times

In an equation-like form image reduction looks like this:

science𝑟𝑒𝑑𝑢𝑐𝑒𝑑 =
science𝑟𝑎𝑤 − dark frame

master flat𝑟𝑒𝑑𝑢𝑐𝑒𝑑, 𝑛𝑜𝑟𝑚𝑎𝑙𝑖𝑧𝑒𝑑

Note the difference between this case and the other: The dark frame includes both bias and dark current so we only
need to do one subtraction from the raw science image.

Todo
1. If for some reason you wanted to could you still, even in case 2, do the data reduction the way it is in case 1?

Explain.

4.3 Science image reduction

Look at the images in the folder reduce-by-hand. It contains a master bias frame a couple of master dark frames
(these have not had the bias subtracted from them), a master flat, and a science image.

Todo
1. Examine the FITS headers of the images. Which of the two data reduction cases in the previous discussion

applies here? Explain.

2. Reduce the science image.
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(a) First, subtract of the bias/dark current or the dark frame (depending on which case applies here). Identify
one or more features of the image that visibly changed when you did this step of the calibration.

(b) Second, use the flat field to correct the illumination. Describe what changes, if any you see in the image.
Hint: As with the previous step, you will need to use the image calculator.

3. Summarize, in your own words, the steps needed to reduce a science image.

4.4 Questions

Todo
1. For each file name below explain why the name would or would not match the pattern twi-.*bias.*

• Twi-bias.fit

• twi-diffuser-flat-001bias.fit

• twi-diffuser-flat-001bias_flt.fit

• twi-diffuser-flat-001bIas.fit

2. Look at the list of the files in the folder for_gain. For each of the items below come up with a pattern that
matches the right files. Check your patterns by starting to open an image sequence in AstroImageJ, selecting the
folder for_gain, entering the pattern in the right place, and verifying that the correct number of files matches.

(a) All bias images that have “twi” in the name (should be 11 files)

(b) The images in the R band (R is in the file name) that also have “flood” in the name and are number 001
through 003 (should be 3 files).

(c) The images in the I band with “flood” in the name (10 items)

(d) The images in the I band with “flood” in the name whose number is odd (001, 003, etc) (should be 5
images)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/aij_sequences.rst, line 55.)

Todo
1. Write down the names of the images you chose.

2. Select a region and write down its width, height, and x and y position.

3. Find the average pixel value in that region in each image you have open. Write them down, clearly indiciating
which measure goes with which image.

4. Calculate the difference between the two bias images.

5. Calculate the difference between the two flat images.

6. Measure the standard deviation in the region you chose in each of the two difference images. Write the result
down, clearly indicating which measurement goes with which difference image.

7. Calculate the gain for the CCD using the formula in Howell’s book.

8. Calculate the read noise for the CCD using the formula in Howell’s book.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/gain_calc_detail.rst, line 24.)
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Todo
1. Imagine subtracting an image from itself. What should the result be? Use AstroImageJ to subtract an image

from itself. Does the result match your expectaion?

2. Imagine dividing an image by itself. What should the result be? Use AstroImageJ to divide an image by itself.
Does the result match your expectation.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_arithmetic.rst, line 13.)

Todo
1. Where is the origin used for the x and y position? In other words, where in the image is the point (0,0)?

2. What is the position of the center of the image?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_measurements.rst, line 18.)

Todo
1. Measure the mean pixel value and the standard deviation of the pixel value for one of the images you have open.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_measurements.rst, line 37.)

Todo
1. Make a histogram for a single bias image. Note the width of the bias histogram, which is twice the standard

deviation, and the mean.

2. Combine four of the bias images. Do this by:

• clicking on sequence window so that it is on top

• clickking on the AstroImageJ toolbar to make sure the correct menus are displayed

• selecting Z-Project from the Stacks menu in the Image menu (i.e. Image -> Stacks -> Z-Project) and...

• ...choosing appropriate values for the starting and ending image in the sequence, and...

• ...choose average as the method of combining.

• Be sure to write down the name of the combined image.

3. Make a histogram of the combination of four bias images. Compare the mean and standard deviation of the
distribution for the combined images with the same numbers for the single image.

4. Repeat for 8 bias images; note the mean and standard deviation.

5. Repeat again for all 16 bias images; note the mean and standard deviation.

6. Describe in words:

(a) How the histogram changes as you increase the number of images in the stack.

(b) How the mean changes as you increase the number of images.

(c) How the standard deviation changes as you increase the number of images.
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7. For this type of error it can be shown that the amount of noise (i.e. the standard deviation) should be inversing
proportional to the square root of the number of images. Does this seem to be true, at least roughly, for the
histograms you just compared?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/stats_1.rst, line 18.)

Todo
1. Combine four images using median to Z-project the images, and make a histogram of the combined image.

2. Combine 16 images using median to Z-project the images, and make a histogram of the combing image.

3. Does the pattern you observed for the change in noise as you increase the number of images still hold for median
combining?

4. Compare the mean and standard deviation of these histograms with the corresponding mean and standard devia-
tion from the images combined using the average. Which results in less noise, combing by average or combining
by median?

5. Why might you median combine images even though there is slightly less noise if you combine images by
averaging?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/stats_1.rst, line 44.)

Todo
1. What is different about the first image in the sequence? Look near pixel coordinates (1480, 820)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 12.)

Todo
1. Can you see the defect in the image made by averaging the stack? Why?

2. Can you see the defect in the image made by median combining the stack? Why?

3. In which stacked image is the defect more visible, the average or the median?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 26.)

Todo
1. If you haven’t yet, normalize the sequence of flat images you have open. Is the average pixel value in the image

roughly the same in each image after normalization? Why isn’t the average pixel value the same as the median
pixel value you set in the normalization dialogue box?

2. Suppose one of the original images had a median pixel value of 23,200 and that you want to have want the
median after normalization to be 2. Describe in detail what you need to do to the image to normalize (detail in
the sense of the math operations you would need to carry out if you were to normalize by hand, not details of
how to do it in AstroImageJ) and explain why your answer is correct.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 52.)

Todo
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1. Make a master bias frame using all of the bias frames in the folder and save the result as a FITS image. Make a
note of:

• Which files went into the master.

• How you combined the files.

• How many files went into the master.

• What you called the master bias frame.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/masters.rst, line 15.)

Todo
1. Make a master dark. Use all of the files in the float folder that start with twi and have D15 in the name.

Combine using a median, and save the result as a FITS image. Make a note of:

• Which files went into the master.

• How you combined the files.

• What the exposure time was for these darks.

• What you called the master dark frame.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/masters.rst, line 43.)

Todo
1. Double-check the exposure time of the flat you opened. Does it match the exposure time of the master dark you

created?

2. Use the image calculator to subtract your master dark from the flat frame that you opened.

3. In principle, the pixel values are now all due to light that fell on the CCD. Pick a pixel, and convert the value
from ADU to photons using the gain you calculated earlier. How many photons was it?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/reduce_a_flat.rst, line 8.)

Todo
1. Open up SIMBAD and look up the information on your target. Make note of any other common names for your

target, its position (in J2000 coordinates), and its magnitude (NOTE: You may want to save a bookmark to your
object’s SIMBAD page).

2. Write down a list of the kind of observations you will need to make for your project (NOT INCLUDING the
biases, darks, and flats you would have to shoot for any telescopic observations). Include the number of images
and which filters you will need to use. You should also note if the images need to be in very dark skies or if
you can shoot in brighter (possibly moonlit) skies. WARNING: One part of planning we are not addressing yet
is estimating how long you need to make your exposures. This is critical because it affects how much you can
actually shoot each night. We will be addressing this next week.

3. Edit the my_objects_list.txt text file to include your target(s) as the first object(s) on the list. You can also delete
any lines for objects you do not intend to observe if you wish.

4. Open up jSkyCalc and load the objects list. Set the date in jSkyCalc to the appropriate date. When is sunset and
sunrise for the night you are checking? You may need to know this to plan for twilight flats.
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5. When does twilight end (evening) and begin (morning)? You may need these times to plan for twilight flats and
to know when science observing can occur.

6. Set the time in jSkyCalc to twilight for that evening. What is the Hour Angle of your target? What does this
mean?

7. What is the airmass profile for your target? What time of night will your target be high enough for it to be a
good time to observe your object, if any? Clarify how you reached this decision (e.g. - What did you look for to
make this decision?)

8. Is the moon going to be a problem for you on March 1-3?

9. Check the “seasonal observability” and confirm when during the spring semester would be a good time of year
to observe the target. Make note of those times as well as how you reached the decision (e.g. - Did you consider
just airmass or did you also need to consider the phase of the moon?)

10. Lastly, to help with you identifying the target at the telescope, put together a Finder Chart with a 20 arcminute wide field of view with a limit of about 17th magnitude. Use one of the following services:

• SIMBAD or

• the MAPS Catalog Finder Chart service or

• AAVSO Variable Star Plotter service.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/03_planning_observations/checking.rst, line 8.)

Todo
1. What project do you think you would like to attempt?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/03_planning_observations/choosing.rst, line 67.)

Todo
1. Suppose your dark frames were exposed for 30 seconds but your science images were 90 second exposures.

Explain how you would need to adjust the dark current images to use them for removing dark current from your
science image.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduce_science_overview.rst, line 44.)

Todo
1. If for some reason you wanted to could you still, even in case 2, do the data reduction the way it is in case 1?

Explain.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduce_science_overview.rst, line 59.)

Todo
1. Examine the FITS headers of the images. Which of the two data reduction cases in the previous discussion

applies here? Explain.

2. Reduce the science image.
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(a) First, subtract of the bias/dark current or the dark frame (depending on which case applies here). Identify
one or more features of the image that visibly changed when you did this step of the calibration.

(b) Second, use the flat field to correct the illumination. Describe what changes, if any you see in the image.
Hint: As with the previous step, you will need to use the image calculator.

3. Summarize, in your own words, the steps needed to reduce a science image.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduction_by_hand.rst, line 6.)

Todo
1. As a refresher, write down the three basic types of calibration you do to images.

2. Open one of the science images you have been asked to reduce.

3. Based on the exposure time and filter of the image, what calibration files will you need?

4. Are there additional calibration images you need to calibrate the calibration images in the previous question? If
yes, what are they?

5. Are there calibration images you need that do not depend on exposure time or filter? What are they?

You should end this section of questions with a clear list of the calibration images you will need (e.g. flats in the Z
filter, darks with an exposure time of 120 hours).

Check your list with any one of the instructors before you move on.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/automated_reduction.rst, line 53.)

Todo
1. How many bias frames should be included by the this automated tool? Note: there is no fancy way to figure this

out. Look at the file names.

2. Does the master bias image that you produced look like a master bias should? By this point you should have
some rough idea of what a master bias looks like and you should have notes on what the typical pixel value is in
a bias frame. Check both of those things.

3. Compare your master bias image to the appropriate reference_images to make sure they are really the same. Do
that by loading both your master bias and ours and using AstroImageJ to take the difference or the ratio (what
would you expect for either?).

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_bias.rst, line 25.)

Todo
1. Review the list of calibration files you made in Get organized before you get going. How many master dark

images will you need to make?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_dark.rst, line 4.)

Todo
1. How many dark frames should be included by the this automated tool for each of the master darks you need to

create? Note: there is no fancy way to figure this out. Look at the file names.
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2. Does the master dark image(s) that you produced look like a master dark should? By this point you should have
some rough idea of what a master dark looks like and you should have notes on what the typical pixel value is
in a dark frame. Check both of those things.

3. Compare your master dark image(s) to the appropriate reference_images to make sure they are really the same.
Do that by loading both your master dark(s) and ours and using AstroImageJ to take the difference or the ratio
(what would you expect for either?).

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_dark.rst, line 32.)

Todo
1. Review the list of calibration files you made in Get organized before you get going. How many master flat

images will you need to make? What filter(s)?

2. What calibration frames will you need to make your master flat?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_flat.rst, line 6.)

Todo
1. How many flat frames should be included by the this automated tool for each of the master flats you need to

create? Note: there is no fancy way to figure this out. Look at the file names.

2. Does the master flat image(s) that you produced look like a master flat should? By this point you should have
some rough idea of what a master flat looks like and you should have notes on what the typical pixel value is in
a flat frame. Check both of those things.

3. Compare your master flat image(s) to the appropriate reference_images to make sure they are really the same. Do that by loading both your master flat(s) and ours and using AstroImageJ to take the difference.

• NOTE: If there turn out to be tiny differences, they may appear to be more significant than they are
when displayed, since AstroImageJ scales the image to the range of values in the image. A better test
might be taking the RATIO of your flat versus the reference flat image if your flat and our reference
flat are just offset from each other by a tiny but constant fraction.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_flat.rst, line 31.)

Todo
1. How many science frames should be included by the this automated tool? Note: there is no fancy way to figure

this out. Look at the file names.

2. Does the calibrated science image look sensible? By now you should be able to recognize if there are obvious
defects (e.g. dust donuts)

3. Compare your science image(s) to the appropriate reference_images to make sure they are really the same.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/reduce.rst, line 30.)

Todo
1. If you choose 𝐶 = 0, what is the instrumental magnitude for the star you measured?
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2. Look at the table of magnitudes handed out (also available here). Does your instrumental magnitude match the
V magnitude of the star you chose? Should it?

3. What would you have to choose C to be for your magnitude to match the magnitude in the table?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/instrumental_mags_and_the_beauty_of_photometry.rst, line 24.)

Todo
1. Talk to someone who chose a different star than you did and calculate the difference in instrumental magnitude

between your two stars.

2. Compare your difference in instrumental magnitude to the difference in the reported magnitudes of the two stars
in the table.

3. Try looking up your two stars in simbad and write down their V magnitudes according to simbad.

• do a coordinate search

• one format for entering coordinates is like: 2.703738h+42.77795d

• RA is first, in decimal hours, followed by declination in decimal degrees

4. Does the magnitude difference as calculated from simbad match what you get from the table we provided? Does
it match your image?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/instrumental_mags_and_the_beauty_of_photometry.rst, line 48.)

Todo
1. What is the FWHM of the star you took the seeing profile of?

2. What does the FWHM mean? Answer both in terms of what the acronym means and an explanation in plain
english what it represents.

3. What aperture size was chosen? How large is it compared to the FWHM (e.g. 2X, or half)?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/photometry_aij.rst, line 21.)

Todo
1. Write down, from the measurement table, for the star you chose:

• the RA and Dec (in decimal hours and decimal degrees)

• net counts (Source-Sky)

• source radius

• minimum and maximum sky radius

• Sky counts/pixel

• Source Error

• Source SNR

2. What was the net number of photons received from the star in the aperture? Hint: Don’t forget about the gain.

3. Pay attention to the folks up front for a brief lecture about error and signal-to-noise ratio (SNR). Take useful
notes.
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4. Calculate the source error and SNR and compare to the values of each from AstroImageJ

5. What is the largest source of error?

6. Of the “noise” terms (dark, sky, read noise), which makes the largest contribution?

7. How could you reduce that source of noise?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/photometry_aij.rst, line 48.)

Todo
1. Add three columns to your data table, one for the instrumental magnitudes of each of the three stars for which

you have photometry. NOTE: AstroImageJ calls the columns that contain the net counts (i.e. 𝑁Source − 𝑁Sky)
something like Source-Sky_T1 or Source-Sky_T2. Use a value of zero for C.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 17.)

Todo
1. Make a graph with airmass on the horizontal axis and instrumental magnitude on the vertical axis, like BGO

Fig. 7.4. Use the “target” star.

• Display the points as points not a line like the book does.

• Excel will pick stupid default values for the airmass values; be sure to at least change the minimum value
to something sensible.

2. Add a trendline to each of the data series. In the options for the trend line:

• Display the fit equation

• Display 𝑅2

3. What would the instrumental magnitude of this star be if corrected for the atmosphere? Hint: What does 𝑚0

represent, physically (mathematically it is the y-intercept of the line you fit to the data)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 35.)

Todo
1. Add the instrumental magnitudes of the other two stars to your graph. The graph should have three sets of points

on it, one set for each of the three stars (i.e. three data series, in Excel-speak).

2. Add trendlines to the new data series.

3. Do all three stars experience the same extinction coefficient, k? Why do you think that is?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 59.)

Todo
1. Open the image “reference-positions.fit” to get the RA and Dec for each of the stars you look at and write them

down in your notebook.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/multi_aperture_photometry.rst, line 36.)
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Todo
1. Write down the FWHM, aperture size, inner sky radius and outer sky radius you chose.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/set_aperture_radius.rst, line 22.)

Todo
1. For my project to succeed, what do I need to actually accurately measure from my science images?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/data_processing_questions.rst, line 6.)

Todo
1. Calibrated Astrometry: Do I need to know where my objects actually are in the sky? Do I need to be concerned

with their motion? Note: None of your projects this year involved tracking moving objects, so this is not critical.
That said, it is a good idea to calibrate your astrometry so that you know where each point in your image actually
is in the sky. Luckily for you, we have already calibrated all your images astrometrically using a software
package called astrometry.net.

2. Calibrated Photometry: Do you need to calibrate your photometry so that it can be compared to others?
That is, do you need to report calibrated magnitudes or can you stick to instrumental magnitudes? If you need
calibrated magnitudes, how would you go about getting them? What standard stars will you use?

3. Atmospheric Extinction Corrections: Do you need to be concerned with determining the extinction and red-
dening per airmass for your target? If so, how could you determine it?

4. Galactic Extinction Corrections: Do you need to be concerned with determining the amount of Galactic
extinction or reddening to your target? Why or why not?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/data_processing_questions.rst, line 11.)

Todo
1. Do you need to stack images in order to bring out faint features in your images? If so, what images do you need

to stack to produce what final images. How will you make sure the stacked images are aligned?

• If you are stacking science images you will need to align them first. Instructions for aligning are at
http://physics.mnstate.edu/craig/astro_project/align.html#align-the-images

• If you need them, instructions for stacking are at http://physics.mnstate.edu/craig/image_stats/stats_1.html#different-
ways-of-combining-average-vs-median

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/image_processing_questions.rst, line 6.)

Todo
1. For my project to succeed, what do I need to actually accurately measure from my science images?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/introduction.rst, line 25.)
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CHAPTER 5

Automated image reduction

Contents:

5.1 Before you begin

• Download the images for today from: http://physics.mnstate.edu/craig/08_files.zip

• Unzip the file by double clicking on it

• Open AstroImageJ (just called ImageJ on the computer)

5.2 (Semi) Automated reduction in AstroImageJ

AstroImageJ can automate much of the image reduction you have learned this semester. That can be very convenient,
but (with apologies to Stan Lee)

5.2.1 With great (data processing) power comes great responsibility

You will make mistakes when using a computer to automate image reduction. Taking careful notes and paying close
attention to what you are doing can help reduce the frequency with which it happens, but at the end of the day you
should expect that mistakes will happen.

The way to deal with that fact–that mistakes will be made–is to build into your procedures for reducing data ways to
check for mistakes. How do you check? The best way is to actually look at your images: the raw calibration files, the
calibration masters and the raw and reduced data.

Note: In the lab today you can click on any thumbnail image to see a full-size version of the image.

5.2.2 Getting to the automated image reduction tool in AstroImageJ

Click the thumbnail images below to see a full-size version.

1. Open AstroImageJ (it will be called just ImageJ on your computer).

2. Click the DP button

3. Two windows will open; close the one titled “DP Coordinate Converter”
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4. Set the directory to the folder containing your images in each of the four places indicated.

The next few sections of the lab will take you through creating a master bias, master dark, and master flat frame, and
applying those calibration frames to science images.

Note: AstroImageJ does allow you to do all of these steps at once. Please do not today...it is extraordinarily easy to
create a large number of incorrect files in a short amount of time.

5.2.3 Get organized before you get going

You have two options at this stage:

• Stop reading here, start trying to make your masters, find you have made several avoidable errors and repeat
several times until you get it right.

• Keep reading.

You have chosen wisely.

To keep things organized you want to start by figuring out what calibration images you need to use. A typical night’s
worth of data will likely have calibration files you don’t need for your particular project or will have different calibra-
tion files needed for different parts of whatever science you are doing.

To figure out what calibration files you need start by opening one of the uncalibrated science images...in the end you
are doing calibration because you want to do with science, so the only answer to question “What calilbration files do I
need?” is “That depends; what does calibrating your science image require?”

The answer to that question always involves looking at the FITS header of your science image.

Todo
1. As a refresher, write down the three basic types of calibration you do to images.

2. Open one of the science images you have been asked to reduce.

3. Based on the exposure time and filter of the image, what calibration files will you need?

4. Are there additional calibration images you need to calibrate the calibration images in the previous question? If
yes, what are they?

5. Are there calibration images you need that do not depend on exposure time or filter? What are they?

You should end this section of questions with a clear list of the calibration images you will need (e.g. flats in the Z
filter, darks with an exposure time of 120 hours).

Check your list with any one of the instructors before you move on.

5.3 Make a master bias image

Change the settings in the “DP” window to match those below.

1. Check only the following:
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• Bias Subtraction -> Build

• Bias Subtraction -> med

2. Find and enter file pattern of bias, e.g. “bias006” or “eyumabias” or “dark_bias”. . . can be weird sometimes, so
watch out.

(a) You can use ? to replace one character or * to replace multiple characters, e.g. bias???.fit could
replace a series which looks like bias242.fit, or *bias* could replace a series which looks like
dark_bias_7.fit

3. Make sure number in Totals next to Bias Subtraction top row is equal to number of bias you have

4. Choose a name to save master as, e.g. mbias or master_bias

5. Click start and watch for errors

Todo
1. How many bias frames should be included by the this automated tool? Note: there is no fancy way to figure this

out. Look at the file names.

2. Does the master bias image that you produced look like a master bias should? By this point you should have
some rough idea of what a master bias looks like and you should have notes on what the typical pixel value is in
a bias frame. Check both of those things.

3. Compare your master bias image to the appropriate reference_images to make sure they are really the same. Do
that by loading both your master bias and ours and using AstroImageJ to take the difference or the ratio (what
would you expect for either?).

5.4 Make master dark image

Todo
1. Review the list of calibration files you made in Get organized before you get going. How many master dark

images will you need to make?

Change the settings in the “DP” window to match those below.

1. Check only the following:

• Bias Subtraction -> Enable

• Dark Subtraction -> Build

• Dark Subtraction -> Scale

• Dark Subtraction -> med

2. Note that since scale is set, it is not necessary to have darks the same length as your science images...though it’s
still nice

3. Find and enter file name pattern for the darks you need.

• See instructions for Make a master bias image for tips on writing file name patterns
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• Review your notes from Get organized before you get going

4. Make sure number in Totals next to Dark Subtraction top row is equal to number of darks you need

5. Make sure number in Totals next to Bias Subtraction second row is 1

6. Choose a name to save master as, e.g. “mdark” or “master_dark”. Remember that you may need to make more
than one master dark, so a specific name is better than a generic name.

7. Click start and watch for errors

Todo
1. How many dark frames should be included by the this automated tool for each of the master darks you need to

create? Note: there is no fancy way to figure this out. Look at the file names.

2. Does the master dark image(s) that you produced look like a master dark should? By this point you should have
some rough idea of what a master dark looks like and you should have notes on what the typical pixel value is
in a dark frame. Check both of those things.

3. Compare your master dark image(s) to the appropriate reference_images to make sure they are really the same.
Do that by loading both your master dark(s) and ours and using AstroImageJ to take the difference or the ratio
(what would you expect for either?).

5.5 Make master flat image

Todo
1. Review the list of calibration files you made in Get organized before you get going. How many master flat

images will you need to make? What filter(s)?

2. What calibration frames will you need to make your master flat?

Change the settings in the “DP” window to match those below.

1. Check only the following:

• Bias Subtraction -> Enable

• Dark Subtraction -> Enable

• Dark Subtraction -> Scale

• Flat Division -> Build

• Flat Division -> med

2. Under the Preferences menu in the “CCD Data Processor” window, make sure “Remove
gradient from calibrated raw flats when creating master flats” option is UNCHECKED.
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3. Find and enter file pattern of flats; see instructions for master bias for tips.

4. Make sure number in Totals next to Flat Division top row is equal to number of flats you have

5. Make sure number in Totals next to Dark Subtraction second row is 1, and that you are using a master dark of
the appropriate exposure.

6. Choose a name to save flat

7. Click start and watch for errors

Todo
1. How many flat frames should be included by the this automated tool for each of the master flats you need to

create? Note: there is no fancy way to figure this out. Look at the file names.

2. Does the master flat image(s) that you produced look like a master flat should? By this point you should have
some rough idea of what a master flat looks like and you should have notes on what the typical pixel value is in
a flat frame. Check both of those things.

3. Compare your master flat image(s) to the appropriate reference_images to make sure they are really the same. Do that by loading both your master flat(s) and ours and using AstroImageJ to take the difference.

• NOTE: If there turn out to be tiny differences, they may appear to be more significant than they are
when displayed, since AstroImageJ scales the image to the range of values in the image. A better test
might be taking the RATIO of your flat versus the reference flat image if your flat and our reference
flat are just offset from each other by a tiny but constant fraction.

5.6 Reduce science image(s)

Note: You only need to calibrate the images for the filter, R, V, or B, that you have been assigned. Though it isn’t the
best way to specify the filter, look for it in the file name and verify it by looking at the FITS header.

Change the settings in the “DP” window to match those below.
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1. Check only the following:

• Filename Pattern Matching -> Enable

• Filename Pattern Matching -> Sort Num

• Bias Subtraction -> Enable

• Dark Subtraction -> Enable

• Dark Subtraction -> Scale

• Flat Division -> Enable

• Save Calibrated Images -> Enable

• Save Calibrated Images -> 32

2. Find and enter file pattern for science images; see master bias instructions for tips.

3. Make sure number in Totals next to Science Image Processing first row is equal to number of science images
you have

4. Make sure number in Totals next to dark subtraction second row is 1 AND that it is the right exposure time.

5. Make sure number in Totals next to Flat division second row is 1 AND that it is the right filter.

6. Pick a subdirectory for your reduced science images and enter it into Save Calibrated Images -> Sub-dir. If the
directory doesn’t already exist, AstroImageJ will create it for you.

7. Pick a suffix for your reduced science images, default is _out

8. Click start and watch for errors

Todo
1. How many science frames should be included by the this automated tool? Note: there is no fancy way to figure

this out. Look at the file names.

2. Does the calibrated science image look sensible? By now you should be able to recognize if there are obvious
defects (e.g. dust donuts)

3. Compare your science image(s) to the appropriate reference_images to make sure they are really the same.

5.7 Questions

Todo
1. For each file name below explain why the name would or would not match the pattern twi-.*bias.*

• Twi-bias.fit

• twi-diffuser-flat-001bias.fit

• twi-diffuser-flat-001bias_flt.fit

• twi-diffuser-flat-001bIas.fit
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2. Look at the list of the files in the folder for_gain. For each of the items below come up with a pattern that
matches the right files. Check your patterns by starting to open an image sequence in AstroImageJ, selecting the
folder for_gain, entering the pattern in the right place, and verifying that the correct number of files matches.

(a) All bias images that have “twi” in the name (should be 11 files)

(b) The images in the R band (R is in the file name) that also have “flood” in the name and are number 001
through 003 (should be 3 files).

(c) The images in the I band with “flood” in the name (10 items)

(d) The images in the I band with “flood” in the name whose number is odd (001, 003, etc) (should be 5
images)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/aij_sequences.rst, line 55.)

Todo
1. Write down the names of the images you chose.

2. Select a region and write down its width, height, and x and y position.

3. Find the average pixel value in that region in each image you have open. Write them down, clearly indiciating
which measure goes with which image.

4. Calculate the difference between the two bias images.

5. Calculate the difference between the two flat images.

6. Measure the standard deviation in the region you chose in each of the two difference images. Write the result
down, clearly indicating which measurement goes with which difference image.

7. Calculate the gain for the CCD using the formula in Howell’s book.

8. Calculate the read noise for the CCD using the formula in Howell’s book.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/gain_calc_detail.rst, line 24.)

Todo
1. Imagine subtracting an image from itself. What should the result be? Use AstroImageJ to subtract an image

from itself. Does the result match your expectaion?

2. Imagine dividing an image by itself. What should the result be? Use AstroImageJ to divide an image by itself.
Does the result match your expectation.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_arithmetic.rst, line 13.)

Todo
1. Where is the origin used for the x and y position? In other words, where in the image is the point (0,0)?

2. What is the position of the center of the image?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_measurements.rst, line 18.)

Todo
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1. Measure the mean pixel value and the standard deviation of the pixel value for one of the images you have open.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_measurements.rst, line 37.)

Todo
1. Make a histogram for a single bias image. Note the width of the bias histogram, which is twice the standard

deviation, and the mean.

2. Combine four of the bias images. Do this by:

• clicking on sequence window so that it is on top

• clickking on the AstroImageJ toolbar to make sure the correct menus are displayed

• selecting Z-Project from the Stacks menu in the Image menu (i.e. Image -> Stacks -> Z-Project) and...

• ...choosing appropriate values for the starting and ending image in the sequence, and...

• ...choose average as the method of combining.

• Be sure to write down the name of the combined image.

3. Make a histogram of the combination of four bias images. Compare the mean and standard deviation of the
distribution for the combined images with the same numbers for the single image.

4. Repeat for 8 bias images; note the mean and standard deviation.

5. Repeat again for all 16 bias images; note the mean and standard deviation.

6. Describe in words:

(a) How the histogram changes as you increase the number of images in the stack.

(b) How the mean changes as you increase the number of images.

(c) How the standard deviation changes as you increase the number of images.

7. For this type of error it can be shown that the amount of noise (i.e. the standard deviation) should be inversing
proportional to the square root of the number of images. Does this seem to be true, at least roughly, for the
histograms you just compared?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/stats_1.rst, line 18.)

Todo
1. Combine four images using median to Z-project the images, and make a histogram of the combined image.

2. Combine 16 images using median to Z-project the images, and make a histogram of the combing image.

3. Does the pattern you observed for the change in noise as you increase the number of images still hold for median
combining?

4. Compare the mean and standard deviation of these histograms with the corresponding mean and standard devia-
tion from the images combined using the average. Which results in less noise, combing by average or combining
by median?

5. Why might you median combine images even though there is slightly less noise if you combine images by
averaging?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/stats_1.rst, line 44.)
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Todo
1. What is different about the first image in the sequence? Look near pixel coordinates (1480, 820)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 12.)

Todo
1. Can you see the defect in the image made by averaging the stack? Why?

2. Can you see the defect in the image made by median combining the stack? Why?

3. In which stacked image is the defect more visible, the average or the median?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 26.)

Todo
1. If you haven’t yet, normalize the sequence of flat images you have open. Is the average pixel value in the image

roughly the same in each image after normalization? Why isn’t the average pixel value the same as the median
pixel value you set in the normalization dialogue box?

2. Suppose one of the original images had a median pixel value of 23,200 and that you want to have want the
median after normalization to be 2. Describe in detail what you need to do to the image to normalize (detail in
the sense of the math operations you would need to carry out if you were to normalize by hand, not details of
how to do it in AstroImageJ) and explain why your answer is correct.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 52.)

Todo
1. Make a master bias frame using all of the bias frames in the folder and save the result as a FITS image. Make a

note of:

• Which files went into the master.

• How you combined the files.

• How many files went into the master.

• What you called the master bias frame.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/masters.rst, line 15.)

Todo
1. Make a master dark. Use all of the files in the float folder that start with twi and have D15 in the name.

Combine using a median, and save the result as a FITS image. Make a note of:

• Which files went into the master.

• How you combined the files.

• What the exposure time was for these darks.

• What you called the master dark frame.
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(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/masters.rst, line 43.)

Todo
1. Double-check the exposure time of the flat you opened. Does it match the exposure time of the master dark you

created?

2. Use the image calculator to subtract your master dark from the flat frame that you opened.

3. In principle, the pixel values are now all due to light that fell on the CCD. Pick a pixel, and convert the value
from ADU to photons using the gain you calculated earlier. How many photons was it?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/reduce_a_flat.rst, line 8.)

Todo
1. Open up SIMBAD and look up the information on your target. Make note of any other common names for your

target, its position (in J2000 coordinates), and its magnitude (NOTE: You may want to save a bookmark to your
object’s SIMBAD page).

2. Write down a list of the kind of observations you will need to make for your project (NOT INCLUDING the
biases, darks, and flats you would have to shoot for any telescopic observations). Include the number of images
and which filters you will need to use. You should also note if the images need to be in very dark skies or if
you can shoot in brighter (possibly moonlit) skies. WARNING: One part of planning we are not addressing yet
is estimating how long you need to make your exposures. This is critical because it affects how much you can
actually shoot each night. We will be addressing this next week.

3. Edit the my_objects_list.txt text file to include your target(s) as the first object(s) on the list. You can also delete
any lines for objects you do not intend to observe if you wish.

4. Open up jSkyCalc and load the objects list. Set the date in jSkyCalc to the appropriate date. When is sunset and
sunrise for the night you are checking? You may need to know this to plan for twilight flats.

5. When does twilight end (evening) and begin (morning)? You may need these times to plan for twilight flats and
to know when science observing can occur.

6. Set the time in jSkyCalc to twilight for that evening. What is the Hour Angle of your target? What does this
mean?

7. What is the airmass profile for your target? What time of night will your target be high enough for it to be a
good time to observe your object, if any? Clarify how you reached this decision (e.g. - What did you look for to
make this decision?)

8. Is the moon going to be a problem for you on March 1-3?

9. Check the “seasonal observability” and confirm when during the spring semester would be a good time of year
to observe the target. Make note of those times as well as how you reached the decision (e.g. - Did you consider
just airmass or did you also need to consider the phase of the moon?)

10. Lastly, to help with you identifying the target at the telescope, put together a Finder Chart with a 20 arcminute wide field of view with a limit of about 17th magnitude. Use one of the following services:

• SIMBAD or

• the MAPS Catalog Finder Chart service or

• AAVSO Variable Star Plotter service.
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(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/03_planning_observations/checking.rst, line 8.)

Todo
1. What project do you think you would like to attempt?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/03_planning_observations/choosing.rst, line 67.)

Todo
1. Suppose your dark frames were exposed for 30 seconds but your science images were 90 second exposures.

Explain how you would need to adjust the dark current images to use them for removing dark current from your
science image.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduce_science_overview.rst, line 44.)

Todo
1. If for some reason you wanted to could you still, even in case 2, do the data reduction the way it is in case 1?

Explain.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduce_science_overview.rst, line 59.)

Todo
1. Examine the FITS headers of the images. Which of the two data reduction cases in the previous discussion

applies here? Explain.

2. Reduce the science image.

(a) First, subtract of the bias/dark current or the dark frame (depending on which case applies here). Identify
one or more features of the image that visibly changed when you did this step of the calibration.

(b) Second, use the flat field to correct the illumination. Describe what changes, if any you see in the image.
Hint: As with the previous step, you will need to use the image calculator.

3. Summarize, in your own words, the steps needed to reduce a science image.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduction_by_hand.rst, line 6.)

Todo
1. As a refresher, write down the three basic types of calibration you do to images.

2. Open one of the science images you have been asked to reduce.

3. Based on the exposure time and filter of the image, what calibration files will you need?

4. Are there additional calibration images you need to calibrate the calibration images in the previous question? If
yes, what are they?

5. Are there calibration images you need that do not depend on exposure time or filter? What are they?
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You should end this section of questions with a clear list of the calibration images you will need (e.g. flats in the Z
filter, darks with an exposure time of 120 hours).

Check your list with any one of the instructors before you move on.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/automated_reduction.rst, line 53.)

Todo
1. How many bias frames should be included by the this automated tool? Note: there is no fancy way to figure this

out. Look at the file names.

2. Does the master bias image that you produced look like a master bias should? By this point you should have
some rough idea of what a master bias looks like and you should have notes on what the typical pixel value is in
a bias frame. Check both of those things.

3. Compare your master bias image to the appropriate reference_images to make sure they are really the same. Do
that by loading both your master bias and ours and using AstroImageJ to take the difference or the ratio (what
would you expect for either?).

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_bias.rst, line 25.)

Todo
1. Review the list of calibration files you made in Get organized before you get going. How many master dark

images will you need to make?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_dark.rst, line 4.)

Todo
1. How many dark frames should be included by the this automated tool for each of the master darks you need to

create? Note: there is no fancy way to figure this out. Look at the file names.

2. Does the master dark image(s) that you produced look like a master dark should? By this point you should have
some rough idea of what a master dark looks like and you should have notes on what the typical pixel value is
in a dark frame. Check both of those things.

3. Compare your master dark image(s) to the appropriate reference_images to make sure they are really the same.
Do that by loading both your master dark(s) and ours and using AstroImageJ to take the difference or the ratio
(what would you expect for either?).

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_dark.rst, line 32.)

Todo
1. Review the list of calibration files you made in Get organized before you get going. How many master flat

images will you need to make? What filter(s)?

2. What calibration frames will you need to make your master flat?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_flat.rst, line 6.)
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Todo
1. How many flat frames should be included by the this automated tool for each of the master flats you need to

create? Note: there is no fancy way to figure this out. Look at the file names.

2. Does the master flat image(s) that you produced look like a master flat should? By this point you should have
some rough idea of what a master flat looks like and you should have notes on what the typical pixel value is in
a flat frame. Check both of those things.

3. Compare your master flat image(s) to the appropriate reference_images to make sure they are really the same. Do that by loading both your master flat(s) and ours and using AstroImageJ to take the difference.

• NOTE: If there turn out to be tiny differences, they may appear to be more significant than they are
when displayed, since AstroImageJ scales the image to the range of values in the image. A better test
might be taking the RATIO of your flat versus the reference flat image if your flat and our reference
flat are just offset from each other by a tiny but constant fraction.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_flat.rst, line 31.)

Todo
1. How many science frames should be included by the this automated tool? Note: there is no fancy way to figure

this out. Look at the file names.

2. Does the calibrated science image look sensible? By now you should be able to recognize if there are obvious
defects (e.g. dust donuts)

3. Compare your science image(s) to the appropriate reference_images to make sure they are really the same.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/reduce.rst, line 30.)

Todo
1. If you choose 𝐶 = 0, what is the instrumental magnitude for the star you measured?

2. Look at the table of magnitudes handed out (also available here). Does your instrumental magnitude match the
V magnitude of the star you chose? Should it?

3. What would you have to choose C to be for your magnitude to match the magnitude in the table?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/instrumental_mags_and_the_beauty_of_photometry.rst, line 24.)

Todo
1. Talk to someone who chose a different star than you did and calculate the difference in instrumental magnitude

between your two stars.

2. Compare your difference in instrumental magnitude to the difference in the reported magnitudes of the two stars
in the table.

3. Try looking up your two stars in simbad and write down their V magnitudes according to simbad.

• do a coordinate search

• one format for entering coordinates is like: 2.703738h+42.77795d

• RA is first, in decimal hours, followed by declination in decimal degrees
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4. Does the magnitude difference as calculated from simbad match what you get from the table we provided? Does
it match your image?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/instrumental_mags_and_the_beauty_of_photometry.rst, line 48.)

Todo
1. What is the FWHM of the star you took the seeing profile of?

2. What does the FWHM mean? Answer both in terms of what the acronym means and an explanation in plain
english what it represents.

3. What aperture size was chosen? How large is it compared to the FWHM (e.g. 2X, or half)?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/photometry_aij.rst, line 21.)

Todo
1. Write down, from the measurement table, for the star you chose:

• the RA and Dec (in decimal hours and decimal degrees)

• net counts (Source-Sky)

• source radius

• minimum and maximum sky radius

• Sky counts/pixel

• Source Error

• Source SNR

2. What was the net number of photons received from the star in the aperture? Hint: Don’t forget about the gain.

3. Pay attention to the folks up front for a brief lecture about error and signal-to-noise ratio (SNR). Take useful
notes.

4. Calculate the source error and SNR and compare to the values of each from AstroImageJ

5. What is the largest source of error?

6. Of the “noise” terms (dark, sky, read noise), which makes the largest contribution?

7. How could you reduce that source of noise?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/photometry_aij.rst, line 48.)

Todo
1. Add three columns to your data table, one for the instrumental magnitudes of each of the three stars for which

you have photometry. NOTE: AstroImageJ calls the columns that contain the net counts (i.e. 𝑁Source − 𝑁Sky)
something like Source-Sky_T1 or Source-Sky_T2. Use a value of zero for C.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 17.)

Todo
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1. Make a graph with airmass on the horizontal axis and instrumental magnitude on the vertical axis, like BGO
Fig. 7.4. Use the “target” star.

• Display the points as points not a line like the book does.

• Excel will pick stupid default values for the airmass values; be sure to at least change the minimum value
to something sensible.

2. Add a trendline to each of the data series. In the options for the trend line:

• Display the fit equation

• Display 𝑅2

3. What would the instrumental magnitude of this star be if corrected for the atmosphere? Hint: What does 𝑚0

represent, physically (mathematically it is the y-intercept of the line you fit to the data)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 35.)

Todo
1. Add the instrumental magnitudes of the other two stars to your graph. The graph should have three sets of points

on it, one set for each of the three stars (i.e. three data series, in Excel-speak).

2. Add trendlines to the new data series.

3. Do all three stars experience the same extinction coefficient, k? Why do you think that is?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 59.)

Todo
1. Open the image “reference-positions.fit” to get the RA and Dec for each of the stars you look at and write them

down in your notebook.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/multi_aperture_photometry.rst, line 36.)

Todo
1. Write down the FWHM, aperture size, inner sky radius and outer sky radius you chose.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/set_aperture_radius.rst, line 22.)

Todo
1. For my project to succeed, what do I need to actually accurately measure from my science images?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/data_processing_questions.rst, line 6.)

Todo
1. Calibrated Astrometry: Do I need to know where my objects actually are in the sky? Do I need to be concerned

with their motion? Note: None of your projects this year involved tracking moving objects, so this is not critical.
That said, it is a good idea to calibrate your astrometry so that you know where each point in your image actually
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is in the sky. Luckily for you, we have already calibrated all your images astrometrically using a software
package called astrometry.net.

2. Calibrated Photometry: Do you need to calibrate your photometry so that it can be compared to others?
That is, do you need to report calibrated magnitudes or can you stick to instrumental magnitudes? If you need
calibrated magnitudes, how would you go about getting them? What standard stars will you use?

3. Atmospheric Extinction Corrections: Do you need to be concerned with determining the extinction and red-
dening per airmass for your target? If so, how could you determine it?

4. Galactic Extinction Corrections: Do you need to be concerned with determining the amount of Galactic
extinction or reddening to your target? Why or why not?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/data_processing_questions.rst, line 11.)

Todo
1. Do you need to stack images in order to bring out faint features in your images? If so, what images do you need

to stack to produce what final images. How will you make sure the stacked images are aligned?

• If you are stacking science images you will need to align them first. Instructions for aligning are at
http://physics.mnstate.edu/craig/astro_project/align.html#align-the-images

• If you need them, instructions for stacking are at http://physics.mnstate.edu/craig/image_stats/stats_1.html#different-
ways-of-combining-average-vs-median

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/image_processing_questions.rst, line 6.)

Todo
1. For my project to succeed, what do I need to actually accurately measure from my science images?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/introduction.rst, line 25.)
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CHAPTER 6

Photometry in AstroImageJ: Introduction

Contents:

6.1 Before you begin

• Download the image for today from here

• Unzip the file by double clicking on it

• Open AstroImageJ (just called ImageJ on the computer)

• Open the image of the cluster M34

6.2 Basic Photometry in AstroImageJ

• Turn on the show-ring button (you must have an image open)

6.2.1 Initial guess for the aperture size

1. Click line selection tool

2. Draw line across one of the stars that is circled in this image:

3. Select Analyze -> Plot seeing profile

4. When asked whether to save the aperture radii, make the following changes:
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• Make the gap between the aperture radius and the inner sky radius at least 5 pixels

• Make the difference between the inner and outer sky radii at least 5 pixels

Note: This is not the best way to set the aperture size or the inner and outer sky radii. We will come back to how to
best choose those later.

Todo
1. What is the FWHM of the star you took the seeing profile of?

2. What does the FWHM mean? Answer both in terms of what the acronym means and an explanation in plain
english what it represents.

3. What aperture size was chosen? How large is it compared to the FWHM (e.g. 2X, or half)?

6.2.2 Setting up aperture photometry

1. Double click on the photometry tool in the toolbar.

2. Check that the first window that opens matches this:

3. When done, click OK, and in the next window that opens check/set several things:

• Gain for the Apogee Alta U9 is roughly 1.48 (feel free to use the value you got earlier this semester)

• Read noise is roughly 28 or 29 electrons per pixel (feel free to use the value you got earlier)

• Dark current is about 0.2 electrons per pixel per second

• The Apogee Alta U9 saturates around 38000 counts.

• Change the FITS headers output to list only AIRMASS and EXPOSURE as shown below, and make sure
the boxes you have checked include at least all of the ones in the image below.

4. Click OK

6.2.3 Doing aperture Photometry

1. Choose one of the stars circled in red below, then, IN IMAGEJ, click on the star.

2. Photometry information will appear in the measurement window.
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Todo
1. Write down, from the measurement table, for the star you chose:

• the RA and Dec (in decimal hours and decimal degrees)

• net counts (Source-Sky)

• source radius

• minimum and maximum sky radius

• Sky counts/pixel

• Source Error

• Source SNR

2. What was the net number of photons received from the star in the aperture? Hint: Don’t forget about the gain.

3. Pay attention to the folks up front for a brief lecture about error and signal-to-noise ratio (SNR). Take useful
notes.

4. Calculate the source error and SNR and compare to the values of each from AstroImageJ

5. What is the largest source of error?

6. Of the “noise” terms (dark, sky, read noise), which makes the largest contribution?

7. How could you reduce that source of noise?

6.3 From counts to magnitudes

Recall that magnitudes are fundamentally defined in terms of flux ratios:

𝑚1 −𝑚2 = −2.5 log
𝑓1
𝑓2

We can’t, strictly speaking, calculate the flux from an image because flux measures energy but a CCD just counts
photons. One reason for using filters is that it at least restricts the photons that hit the detector to a narrower energy
range than without a filter, so that the number of photons received is at least roughly proportional to the amount of
energy received.

Setting aside the energy, the flux is the ratio of the counts from the star to the exposure time (really flux has units
energy/time/area, but since we are using the same area for all of the stars we measure and we already agreed to punt
on the energy, we are left with counts per time).

6.3.1 Instrumental magnitude

Though we can’t actually calculate any magnitudes by themselves, ever, only magnitude differences, it is sometimes
convenient to define an instrumental magnitude like this:

𝑚𝑖𝑛𝑠𝑡 = −2.5 log(𝑁/𝑡) + 𝐶

where t is the exposure time, N is the number of total number of photons from the source (don’t forget the gain!), and
C is a completely arbitrary constant. You can choose any value you want as long as you consistently use that value for
calculating all of your instrumental magnitudes.
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Todo
1. If you choose 𝐶 = 0, what is the instrumental magnitude for the star you measured?

2. Look at the table of magnitudes handed out (also available here). Does your instrumental magnitude match the
V magnitude of the star you chose? Should it?

3. What would you have to choose C to be for your magnitude to match the magnitude in the table?

6.3.2 Magnitude differences

Though instrumental magnitudes are not, by themselves, expected to match the magnitude in a catalog you might
expect magnitude differences to match. Consider two stars whose instrumental magnitudes are 𝑚1,𝑖 and 𝑚2,𝑖. Then
the difference of the instrumental magnitudes is

𝑚1,𝑖 −𝑚2,𝑖 = (−2.5 log(𝑁1/𝑡1) + 𝐶) − (−2.5 log(𝑁2/𝑡2) + 𝐶) = −2.5 log

(︂
𝑁1

𝑡1

𝑡2
𝑁2

)︂
If the exposure time is the same in both measurements, this simplifies a little bit, to

𝑚1,𝑖 −𝑚2,𝑖 = −2.5 log
𝑁1

𝑁2
.

Since the constant C cancels out when we take a magnitude difference, we should expect that different observers
will agree on magnitude differences even if the two observers use different instruments, different aperture sizes, and
different exposure times.

Todo
1. Talk to someone who chose a different star than you did and calculate the difference in instrumental magnitude

between your two stars.

2. Compare your difference in instrumental magnitude to the difference in the reported magnitudes of the two stars
in the table.

3. Try looking up your two stars in simbad and write down their V magnitudes according to simbad.

• do a coordinate search

• one format for entering coordinates is like: 2.703738h+42.77795d

• RA is first, in decimal hours, followed by declination in decimal degrees

4. Does the magnitude difference as calculated from simbad match what you get from the table we provided? Does
it match your image?

6.4 Questions

Todo
1. For each file name below explain why the name would or would not match the pattern twi-.*bias.*

• Twi-bias.fit

• twi-diffuser-flat-001bias.fit

• twi-diffuser-flat-001bias_flt.fit
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• twi-diffuser-flat-001bIas.fit

2. Look at the list of the files in the folder for_gain. For each of the items below come up with a pattern that
matches the right files. Check your patterns by starting to open an image sequence in AstroImageJ, selecting the
folder for_gain, entering the pattern in the right place, and verifying that the correct number of files matches.

(a) All bias images that have “twi” in the name (should be 11 files)

(b) The images in the R band (R is in the file name) that also have “flood” in the name and are number 001
through 003 (should be 3 files).

(c) The images in the I band with “flood” in the name (10 items)

(d) The images in the I band with “flood” in the name whose number is odd (001, 003, etc) (should be 5
images)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/aij_sequences.rst, line 55.)

Todo
1. Write down the names of the images you chose.

2. Select a region and write down its width, height, and x and y position.

3. Find the average pixel value in that region in each image you have open. Write them down, clearly indiciating
which measure goes with which image.

4. Calculate the difference between the two bias images.

5. Calculate the difference between the two flat images.

6. Measure the standard deviation in the region you chose in each of the two difference images. Write the result
down, clearly indicating which measurement goes with which difference image.

7. Calculate the gain for the CCD using the formula in Howell’s book.

8. Calculate the read noise for the CCD using the formula in Howell’s book.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/gain_calc_detail.rst, line 24.)

Todo
1. Imagine subtracting an image from itself. What should the result be? Use AstroImageJ to subtract an image

from itself. Does the result match your expectaion?

2. Imagine dividing an image by itself. What should the result be? Use AstroImageJ to divide an image by itself.
Does the result match your expectation.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_arithmetic.rst, line 13.)

Todo
1. Where is the origin used for the x and y position? In other words, where in the image is the point (0,0)?

2. What is the position of the center of the image?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_measurements.rst, line 18.)
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Todo
1. Measure the mean pixel value and the standard deviation of the pixel value for one of the images you have open.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_measurements.rst, line 37.)

Todo
1. Make a histogram for a single bias image. Note the width of the bias histogram, which is twice the standard

deviation, and the mean.

2. Combine four of the bias images. Do this by:

• clicking on sequence window so that it is on top

• clickking on the AstroImageJ toolbar to make sure the correct menus are displayed

• selecting Z-Project from the Stacks menu in the Image menu (i.e. Image -> Stacks -> Z-Project) and...

• ...choosing appropriate values for the starting and ending image in the sequence, and...

• ...choose average as the method of combining.

• Be sure to write down the name of the combined image.

3. Make a histogram of the combination of four bias images. Compare the mean and standard deviation of the
distribution for the combined images with the same numbers for the single image.

4. Repeat for 8 bias images; note the mean and standard deviation.

5. Repeat again for all 16 bias images; note the mean and standard deviation.

6. Describe in words:

(a) How the histogram changes as you increase the number of images in the stack.

(b) How the mean changes as you increase the number of images.

(c) How the standard deviation changes as you increase the number of images.

7. For this type of error it can be shown that the amount of noise (i.e. the standard deviation) should be inversing
proportional to the square root of the number of images. Does this seem to be true, at least roughly, for the
histograms you just compared?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/stats_1.rst, line 18.)

Todo
1. Combine four images using median to Z-project the images, and make a histogram of the combined image.

2. Combine 16 images using median to Z-project the images, and make a histogram of the combing image.

3. Does the pattern you observed for the change in noise as you increase the number of images still hold for median
combining?

4. Compare the mean and standard deviation of these histograms with the corresponding mean and standard devia-
tion from the images combined using the average. Which results in less noise, combing by average or combining
by median?

5. Why might you median combine images even though there is slightly less noise if you combine images by
averaging?
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(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/stats_1.rst, line 44.)

Todo
1. What is different about the first image in the sequence? Look near pixel coordinates (1480, 820)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 12.)

Todo
1. Can you see the defect in the image made by averaging the stack? Why?

2. Can you see the defect in the image made by median combining the stack? Why?

3. In which stacked image is the defect more visible, the average or the median?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 26.)

Todo
1. If you haven’t yet, normalize the sequence of flat images you have open. Is the average pixel value in the image

roughly the same in each image after normalization? Why isn’t the average pixel value the same as the median
pixel value you set in the normalization dialogue box?

2. Suppose one of the original images had a median pixel value of 23,200 and that you want to have want the
median after normalization to be 2. Describe in detail what you need to do to the image to normalize (detail in
the sense of the math operations you would need to carry out if you were to normalize by hand, not details of
how to do it in AstroImageJ) and explain why your answer is correct.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 52.)

Todo
1. Make a master bias frame using all of the bias frames in the folder and save the result as a FITS image. Make a

note of:

• Which files went into the master.

• How you combined the files.

• How many files went into the master.

• What you called the master bias frame.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/masters.rst, line 15.)

Todo
1. Make a master dark. Use all of the files in the float folder that start with twi and have D15 in the name.

Combine using a median, and save the result as a FITS image. Make a note of:

• Which files went into the master.

• How you combined the files.
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• What the exposure time was for these darks.

• What you called the master dark frame.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/masters.rst, line 43.)

Todo
1. Double-check the exposure time of the flat you opened. Does it match the exposure time of the master dark you

created?

2. Use the image calculator to subtract your master dark from the flat frame that you opened.

3. In principle, the pixel values are now all due to light that fell on the CCD. Pick a pixel, and convert the value
from ADU to photons using the gain you calculated earlier. How many photons was it?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/reduce_a_flat.rst, line 8.)

Todo
1. Open up SIMBAD and look up the information on your target. Make note of any other common names for your

target, its position (in J2000 coordinates), and its magnitude (NOTE: You may want to save a bookmark to your
object’s SIMBAD page).

2. Write down a list of the kind of observations you will need to make for your project (NOT INCLUDING the
biases, darks, and flats you would have to shoot for any telescopic observations). Include the number of images
and which filters you will need to use. You should also note if the images need to be in very dark skies or if
you can shoot in brighter (possibly moonlit) skies. WARNING: One part of planning we are not addressing yet
is estimating how long you need to make your exposures. This is critical because it affects how much you can
actually shoot each night. We will be addressing this next week.

3. Edit the my_objects_list.txt text file to include your target(s) as the first object(s) on the list. You can also delete
any lines for objects you do not intend to observe if you wish.

4. Open up jSkyCalc and load the objects list. Set the date in jSkyCalc to the appropriate date. When is sunset and
sunrise for the night you are checking? You may need to know this to plan for twilight flats.

5. When does twilight end (evening) and begin (morning)? You may need these times to plan for twilight flats and
to know when science observing can occur.

6. Set the time in jSkyCalc to twilight for that evening. What is the Hour Angle of your target? What does this
mean?

7. What is the airmass profile for your target? What time of night will your target be high enough for it to be a
good time to observe your object, if any? Clarify how you reached this decision (e.g. - What did you look for to
make this decision?)

8. Is the moon going to be a problem for you on March 1-3?

9. Check the “seasonal observability” and confirm when during the spring semester would be a good time of year
to observe the target. Make note of those times as well as how you reached the decision (e.g. - Did you consider
just airmass or did you also need to consider the phase of the moon?)

10. Lastly, to help with you identifying the target at the telescope, put together a Finder Chart with a 20 arcminute wide field of view with a limit of about 17th magnitude. Use one of the following services:

• SIMBAD or

• the MAPS Catalog Finder Chart service or
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• AAVSO Variable Star Plotter service.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/03_planning_observations/checking.rst, line 8.)

Todo
1. What project do you think you would like to attempt?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/03_planning_observations/choosing.rst, line 67.)

Todo
1. Suppose your dark frames were exposed for 30 seconds but your science images were 90 second exposures.

Explain how you would need to adjust the dark current images to use them for removing dark current from your
science image.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduce_science_overview.rst, line 44.)

Todo
1. If for some reason you wanted to could you still, even in case 2, do the data reduction the way it is in case 1?

Explain.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduce_science_overview.rst, line 59.)

Todo
1. Examine the FITS headers of the images. Which of the two data reduction cases in the previous discussion

applies here? Explain.

2. Reduce the science image.

(a) First, subtract of the bias/dark current or the dark frame (depending on which case applies here). Identify
one or more features of the image that visibly changed when you did this step of the calibration.

(b) Second, use the flat field to correct the illumination. Describe what changes, if any you see in the image.
Hint: As with the previous step, you will need to use the image calculator.

3. Summarize, in your own words, the steps needed to reduce a science image.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduction_by_hand.rst, line 6.)

Todo
1. As a refresher, write down the three basic types of calibration you do to images.

2. Open one of the science images you have been asked to reduce.

3. Based on the exposure time and filter of the image, what calibration files will you need?

4. Are there additional calibration images you need to calibrate the calibration images in the previous question? If
yes, what are they?

5. Are there calibration images you need that do not depend on exposure time or filter? What are they?
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You should end this section of questions with a clear list of the calibration images you will need (e.g. flats in the Z
filter, darks with an exposure time of 120 hours).

Check your list with any one of the instructors before you move on.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/automated_reduction.rst, line 53.)

Todo
1. How many bias frames should be included by the this automated tool? Note: there is no fancy way to figure this

out. Look at the file names.

2. Does the master bias image that you produced look like a master bias should? By this point you should have
some rough idea of what a master bias looks like and you should have notes on what the typical pixel value is in
a bias frame. Check both of those things.

3. Compare your master bias image to the appropriate reference_images to make sure they are really the same. Do
that by loading both your master bias and ours and using AstroImageJ to take the difference or the ratio (what
would you expect for either?).

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_bias.rst, line 25.)

Todo
1. Review the list of calibration files you made in Get organized before you get going. How many master dark

images will you need to make?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_dark.rst, line 4.)

Todo
1. How many dark frames should be included by the this automated tool for each of the master darks you need to

create? Note: there is no fancy way to figure this out. Look at the file names.

2. Does the master dark image(s) that you produced look like a master dark should? By this point you should have
some rough idea of what a master dark looks like and you should have notes on what the typical pixel value is
in a dark frame. Check both of those things.

3. Compare your master dark image(s) to the appropriate reference_images to make sure they are really the same.
Do that by loading both your master dark(s) and ours and using AstroImageJ to take the difference or the ratio
(what would you expect for either?).

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_dark.rst, line 32.)

Todo
1. Review the list of calibration files you made in Get organized before you get going. How many master flat

images will you need to make? What filter(s)?

2. What calibration frames will you need to make your master flat?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_flat.rst, line 6.)
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Todo
1. How many flat frames should be included by the this automated tool for each of the master flats you need to

create? Note: there is no fancy way to figure this out. Look at the file names.

2. Does the master flat image(s) that you produced look like a master flat should? By this point you should have
some rough idea of what a master flat looks like and you should have notes on what the typical pixel value is in
a flat frame. Check both of those things.

3. Compare your master flat image(s) to the appropriate reference_images to make sure they are really the same. Do that by loading both your master flat(s) and ours and using AstroImageJ to take the difference.

• NOTE: If there turn out to be tiny differences, they may appear to be more significant than they are
when displayed, since AstroImageJ scales the image to the range of values in the image. A better test
might be taking the RATIO of your flat versus the reference flat image if your flat and our reference
flat are just offset from each other by a tiny but constant fraction.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_flat.rst, line 31.)

Todo
1. How many science frames should be included by the this automated tool? Note: there is no fancy way to figure

this out. Look at the file names.

2. Does the calibrated science image look sensible? By now you should be able to recognize if there are obvious
defects (e.g. dust donuts)

3. Compare your science image(s) to the appropriate reference_images to make sure they are really the same.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/reduce.rst, line 30.)

Todo
1. If you choose 𝐶 = 0, what is the instrumental magnitude for the star you measured?

2. Look at the table of magnitudes handed out (also available here). Does your instrumental magnitude match the
V magnitude of the star you chose? Should it?

3. What would you have to choose C to be for your magnitude to match the magnitude in the table?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/instrumental_mags_and_the_beauty_of_photometry.rst, line 24.)

Todo
1. Talk to someone who chose a different star than you did and calculate the difference in instrumental magnitude

between your two stars.

2. Compare your difference in instrumental magnitude to the difference in the reported magnitudes of the two stars
in the table.

3. Try looking up your two stars in simbad and write down their V magnitudes according to simbad.

• do a coordinate search

• one format for entering coordinates is like: 2.703738h+42.77795d

• RA is first, in decimal hours, followed by declination in decimal degrees
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4. Does the magnitude difference as calculated from simbad match what you get from the table we provided? Does
it match your image?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/instrumental_mags_and_the_beauty_of_photometry.rst, line 48.)

Todo
1. What is the FWHM of the star you took the seeing profile of?

2. What does the FWHM mean? Answer both in terms of what the acronym means and an explanation in plain
english what it represents.

3. What aperture size was chosen? How large is it compared to the FWHM (e.g. 2X, or half)?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/photometry_aij.rst, line 21.)

Todo
1. Write down, from the measurement table, for the star you chose:

• the RA and Dec (in decimal hours and decimal degrees)

• net counts (Source-Sky)

• source radius

• minimum and maximum sky radius

• Sky counts/pixel

• Source Error

• Source SNR

2. What was the net number of photons received from the star in the aperture? Hint: Don’t forget about the gain.

3. Pay attention to the folks up front for a brief lecture about error and signal-to-noise ratio (SNR). Take useful
notes.

4. Calculate the source error and SNR and compare to the values of each from AstroImageJ

5. What is the largest source of error?

6. Of the “noise” terms (dark, sky, read noise), which makes the largest contribution?

7. How could you reduce that source of noise?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/photometry_aij.rst, line 48.)

Todo
1. Add three columns to your data table, one for the instrumental magnitudes of each of the three stars for which

you have photometry. NOTE: AstroImageJ calls the columns that contain the net counts (i.e. 𝑁Source − 𝑁Sky)
something like Source-Sky_T1 or Source-Sky_T2. Use a value of zero for C.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 17.)

Todo
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1. Make a graph with airmass on the horizontal axis and instrumental magnitude on the vertical axis, like BGO
Fig. 7.4. Use the “target” star.

• Display the points as points not a line like the book does.

• Excel will pick stupid default values for the airmass values; be sure to at least change the minimum value
to something sensible.

2. Add a trendline to each of the data series. In the options for the trend line:

• Display the fit equation

• Display 𝑅2

3. What would the instrumental magnitude of this star be if corrected for the atmosphere? Hint: What does 𝑚0

represent, physically (mathematically it is the y-intercept of the line you fit to the data)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 35.)

Todo
1. Add the instrumental magnitudes of the other two stars to your graph. The graph should have three sets of points

on it, one set for each of the three stars (i.e. three data series, in Excel-speak).

2. Add trendlines to the new data series.

3. Do all three stars experience the same extinction coefficient, k? Why do you think that is?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 59.)

Todo
1. Open the image “reference-positions.fit” to get the RA and Dec for each of the stars you look at and write them

down in your notebook.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/multi_aperture_photometry.rst, line 36.)

Todo
1. Write down the FWHM, aperture size, inner sky radius and outer sky radius you chose.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/set_aperture_radius.rst, line 22.)

Todo
1. For my project to succeed, what do I need to actually accurately measure from my science images?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/data_processing_questions.rst, line 6.)

Todo
1. Calibrated Astrometry: Do I need to know where my objects actually are in the sky? Do I need to be concerned

with their motion? Note: None of your projects this year involved tracking moving objects, so this is not critical.
That said, it is a good idea to calibrate your astrometry so that you know where each point in your image actually
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is in the sky. Luckily for you, we have already calibrated all your images astrometrically using a software
package called astrometry.net.

2. Calibrated Photometry: Do you need to calibrate your photometry so that it can be compared to others?
That is, do you need to report calibrated magnitudes or can you stick to instrumental magnitudes? If you need
calibrated magnitudes, how would you go about getting them? What standard stars will you use?

3. Atmospheric Extinction Corrections: Do you need to be concerned with determining the extinction and red-
dening per airmass for your target? If so, how could you determine it?

4. Galactic Extinction Corrections: Do you need to be concerned with determining the amount of Galactic
extinction or reddening to your target? Why or why not?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/data_processing_questions.rst, line 11.)

Todo
1. Do you need to stack images in order to bring out faint features in your images? If so, what images do you need

to stack to produce what final images. How will you make sure the stacked images are aligned?

• If you are stacking science images you will need to align them first. Instructions for aligning are at
http://physics.mnstate.edu/craig/astro_project/align.html#align-the-images

• If you need them, instructions for stacking are at http://physics.mnstate.edu/craig/image_stats/stats_1.html#different-
ways-of-combining-average-vs-median

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/image_processing_questions.rst, line 6.)

Todo
1. For my project to succeed, what do I need to actually accurately measure from my science images?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/introduction.rst, line 25.)
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CHAPTER 7

Multi-aperture photometry (and the effects of airmass)

Contents:

7.1 Before you begin

• Download the images for today:

– big package: http://physics.mnstate.edu/craig/ey_uma_03_21/ey-uma-all.zip

– additional file: http://physics.mnstate.edu/craig/ey_uma_03_21/reference-positions.fit

• Unzip the file by double clicking on it

• Open AstroImageJ (just called ImageJ on the computer)

7.2 Photometry setup

Recall that the radius you choose for the aperture you use for photometry can have a large impact on how accurate
your final result is.

7.2.1 Choose the aperture size

You will explore in a homework how to choose the optimal aperture size (you saw an illustration of it in the lecture
right before spring break); for now:

• Set the aperture radius to 1.5 times the FWHM of one of the dimmer stars in the first image.

– If you need a reminder as to how to find the FWHM look at this page from the last lab

• Make the gap between the aperture radius and the inner sky radius at least 5 pixels.

• Choose an outer sky radius such that the number of pixels in the sky annulus is at least twice as large as the
number of pixels in the aperture.

– Remember, you find the number of pixels by just finding the area.

– A large number of background pixels reduces the error in your final measurements.

Todo
1. Write down the FWHM, aperture size, inner sky radius and outer sky radius you chose.
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7.2.2 Set up photometry for bare-bones data collection

The settings we will use today are NOT appropriate for most times you do data collection, because we won’t have
AstroImageJ calculate error and SNR for us. These settings have the advantage of being easier to work with after we
export to Excel, though.

• Get to the aperture photometry settings by by clicking on the “Set Photometry” button, or double clicking the
aperture photometry button or by going to the appropriate menu in AIJ.

• In the first screen, uncheck many of the boxes, as shown here:

• In the second screen also uncheck most of the boxes and set only a few FITS keywords to be saved, as shown

here:

7.3 Multi-aperture photometry in AstroImageJ

AstroImageJ, like other similar software packages, makes it easy to do photometry on several stars at once.

Multi-aperture photometry is a little more interesting if there is more than one image to work on (but note, for the
record, that you could do multi-aperture photometry on a single image, which might be useful for, say, a star cluster),
so...

• Open all of the EY UMa images in a stack.

• MAKE VERY SURE YOU CHECK THE “Use virtual stack” BOX. If you forget, ImageJ will complain,
then quit.

• Once you have the stack open, click the multi-aperture photometry tool:

• In the box that opens, make sure you uncheck the “Use previous...apertures” option. Ideally, set it up as shown

here:

7.3.1 Doing the photometry

1. First, left-click on your target star.

• There is nothing special about the target star except that ImageJ draws the rings around it in a different
color, and handles it differently in the automatic graphing that it does.

2. Next, left-click on as many other stars as you want photometry for. For this exercise, select a total of three stars,
including the target. The three stars you should look at are shown below:
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1. When you have selected all of the stars you want, right-click anywhere in the image. AstroImageJ will start
advancing through the stack, automatically finding the stars in each image. NOTE: a data table will also
automatically open as AstroImageJ works through the images.

Note: At some point AstroImageJ may get stuck because it can’t find the stars. That happens because it uses a simple
(and fairly safe) way for finding the star in each image: it looks for a point of light within roughly 2X the aperture size
of where the star was in the previous image. If the image is shifted more than that, then AstroImageJ stops.

To get it started again, click on the multi-aperture tool. In the window that opens (same window that opened the first
time) be sure to check the box that says “Use previous....apertures”, then click OK.

Left-click on the target star and AstroImageJ will get started again.

1. Save the data table.

Todo
1. Open the image “reference-positions.fit” to get the RA and Dec for each of the stars you look at and write them

down in your notebook.
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7.4 Magnitude and airmass

Please begin by opening your data table in Excel.

7.4.1 Calculating instrumental magnitude

BGO give a formula for instrumental magnitude in terms of counts:

𝑚 = −2.5 log10(𝑁Source −𝑁Sky) + 2.5 log10(𝑡) + 𝐶

where t is the exposure time, N is the number of counts and C is a constant that depends on filter and the CCD.

Todo
1. Add three columns to your data table, one for the instrumental magnitudes of each of the three stars for which

you have photometry. NOTE: AstroImageJ calls the columns that contain the net counts (i.e. 𝑁Source − 𝑁Sky)
something like Source-Sky_T1 or Source-Sky_T2. Use a value of zero for C.

7.4.2 Airmass and instrumental magnitude

In the last class we discussed extinction (also in Chapter 7 of BGO). In this part of the lab you will investigate the
relationship between airmass and instrumental magnitude.

In BGO the relationship between the two is written

𝑚 = 𝑚0 + 𝑘𝑋,

where m is the instrumental magnitude, X is the airmass, and k is the extinction coefficient.

Todo
1. Make a graph with airmass on the horizontal axis and instrumental magnitude on the vertical axis, like BGO

Fig. 7.4. Use the “target” star.

• Display the points as points not a line like the book does.

• Excel will pick stupid default values for the airmass values; be sure to at least change the minimum value
to something sensible.

2. Add a trendline to each of the data series. In the options for the trend line:

• Display the fit equation

• Display 𝑅2

3. What would the instrumental magnitude of this star be if corrected for the atmosphere? Hint: What does 𝑚0

represent, physically (mathematically it is the y-intercept of the line you fit to the data)

7.4.3 Airmass and color

According to BGO, stars of different color experience different extinction; this is shown in Fig. 7.6.

Warning: Fig. 7.3(b) is not showing the way extinction changes for stars of different colors.

Todo
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1. Add the instrumental magnitudes of the other two stars to your graph. The graph should have three sets of points
on it, one set for each of the three stars (i.e. three data series, in Excel-speak).

2. Add trendlines to the new data series.

3. Do all three stars experience the same extinction coefficient, k? Why do you think that is?

7.5 Questions

Todo
1. For each file name below explain why the name would or would not match the pattern twi-.*bias.*

• Twi-bias.fit

• twi-diffuser-flat-001bias.fit

• twi-diffuser-flat-001bias_flt.fit

• twi-diffuser-flat-001bIas.fit

2. Look at the list of the files in the folder for_gain. For each of the items below come up with a pattern that
matches the right files. Check your patterns by starting to open an image sequence in AstroImageJ, selecting the
folder for_gain, entering the pattern in the right place, and verifying that the correct number of files matches.

(a) All bias images that have “twi” in the name (should be 11 files)

(b) The images in the R band (R is in the file name) that also have “flood” in the name and are number 001
through 003 (should be 3 files).

(c) The images in the I band with “flood” in the name (10 items)

(d) The images in the I band with “flood” in the name whose number is odd (001, 003, etc) (should be 5
images)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/aij_sequences.rst, line 55.)

Todo
1. Write down the names of the images you chose.

2. Select a region and write down its width, height, and x and y position.

3. Find the average pixel value in that region in each image you have open. Write them down, clearly indiciating
which measure goes with which image.

4. Calculate the difference between the two bias images.

5. Calculate the difference between the two flat images.

6. Measure the standard deviation in the region you chose in each of the two difference images. Write the result
down, clearly indicating which measurement goes with which difference image.

7. Calculate the gain for the CCD using the formula in Howell’s book.

8. Calculate the read noise for the CCD using the formula in Howell’s book.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/gain_calc_detail.rst, line 24.)
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Todo
1. Imagine subtracting an image from itself. What should the result be? Use AstroImageJ to subtract an image

from itself. Does the result match your expectaion?

2. Imagine dividing an image by itself. What should the result be? Use AstroImageJ to divide an image by itself.
Does the result match your expectation.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_arithmetic.rst, line 13.)

Todo
1. Where is the origin used for the x and y position? In other words, where in the image is the point (0,0)?

2. What is the position of the center of the image?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_measurements.rst, line 18.)

Todo
1. Measure the mean pixel value and the standard deviation of the pixel value for one of the images you have open.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_measurements.rst, line 37.)

Todo
1. Make a histogram for a single bias image. Note the width of the bias histogram, which is twice the standard

deviation, and the mean.

2. Combine four of the bias images. Do this by:

• clicking on sequence window so that it is on top

• clickking on the AstroImageJ toolbar to make sure the correct menus are displayed

• selecting Z-Project from the Stacks menu in the Image menu (i.e. Image -> Stacks -> Z-Project) and...

• ...choosing appropriate values for the starting and ending image in the sequence, and...

• ...choose average as the method of combining.

• Be sure to write down the name of the combined image.

3. Make a histogram of the combination of four bias images. Compare the mean and standard deviation of the
distribution for the combined images with the same numbers for the single image.

4. Repeat for 8 bias images; note the mean and standard deviation.

5. Repeat again for all 16 bias images; note the mean and standard deviation.

6. Describe in words:

(a) How the histogram changes as you increase the number of images in the stack.

(b) How the mean changes as you increase the number of images.

(c) How the standard deviation changes as you increase the number of images.

7. For this type of error it can be shown that the amount of noise (i.e. the standard deviation) should be inversing
proportional to the square root of the number of images. Does this seem to be true, at least roughly, for the
histograms you just compared?
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(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/stats_1.rst, line 18.)

Todo
1. Combine four images using median to Z-project the images, and make a histogram of the combined image.

2. Combine 16 images using median to Z-project the images, and make a histogram of the combing image.

3. Does the pattern you observed for the change in noise as you increase the number of images still hold for median
combining?

4. Compare the mean and standard deviation of these histograms with the corresponding mean and standard devia-
tion from the images combined using the average. Which results in less noise, combing by average or combining
by median?

5. Why might you median combine images even though there is slightly less noise if you combine images by
averaging?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/stats_1.rst, line 44.)

Todo
1. What is different about the first image in the sequence? Look near pixel coordinates (1480, 820)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 12.)

Todo
1. Can you see the defect in the image made by averaging the stack? Why?

2. Can you see the defect in the image made by median combining the stack? Why?

3. In which stacked image is the defect more visible, the average or the median?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 26.)

Todo
1. If you haven’t yet, normalize the sequence of flat images you have open. Is the average pixel value in the image

roughly the same in each image after normalization? Why isn’t the average pixel value the same as the median
pixel value you set in the normalization dialogue box?

2. Suppose one of the original images had a median pixel value of 23,200 and that you want to have want the
median after normalization to be 2. Describe in detail what you need to do to the image to normalize (detail in
the sense of the math operations you would need to carry out if you were to normalize by hand, not details of
how to do it in AstroImageJ) and explain why your answer is correct.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 52.)

Todo
1. Make a master bias frame using all of the bias frames in the folder and save the result as a FITS image. Make a

note of:
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• Which files went into the master.

• How you combined the files.

• How many files went into the master.

• What you called the master bias frame.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/masters.rst, line 15.)

Todo
1. Make a master dark. Use all of the files in the float folder that start with twi and have D15 in the name.

Combine using a median, and save the result as a FITS image. Make a note of:

• Which files went into the master.

• How you combined the files.

• What the exposure time was for these darks.

• What you called the master dark frame.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/masters.rst, line 43.)

Todo
1. Double-check the exposure time of the flat you opened. Does it match the exposure time of the master dark you

created?

2. Use the image calculator to subtract your master dark from the flat frame that you opened.

3. In principle, the pixel values are now all due to light that fell on the CCD. Pick a pixel, and convert the value
from ADU to photons using the gain you calculated earlier. How many photons was it?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/reduce_a_flat.rst, line 8.)

Todo
1. Open up SIMBAD and look up the information on your target. Make note of any other common names for your

target, its position (in J2000 coordinates), and its magnitude (NOTE: You may want to save a bookmark to your
object’s SIMBAD page).

2. Write down a list of the kind of observations you will need to make for your project (NOT INCLUDING the
biases, darks, and flats you would have to shoot for any telescopic observations). Include the number of images
and which filters you will need to use. You should also note if the images need to be in very dark skies or if
you can shoot in brighter (possibly moonlit) skies. WARNING: One part of planning we are not addressing yet
is estimating how long you need to make your exposures. This is critical because it affects how much you can
actually shoot each night. We will be addressing this next week.

3. Edit the my_objects_list.txt text file to include your target(s) as the first object(s) on the list. You can also delete
any lines for objects you do not intend to observe if you wish.

4. Open up jSkyCalc and load the objects list. Set the date in jSkyCalc to the appropriate date. When is sunset and
sunrise for the night you are checking? You may need to know this to plan for twilight flats.

5. When does twilight end (evening) and begin (morning)? You may need these times to plan for twilight flats and
to know when science observing can occur.
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6. Set the time in jSkyCalc to twilight for that evening. What is the Hour Angle of your target? What does this
mean?

7. What is the airmass profile for your target? What time of night will your target be high enough for it to be a
good time to observe your object, if any? Clarify how you reached this decision (e.g. - What did you look for to
make this decision?)

8. Is the moon going to be a problem for you on March 1-3?

9. Check the “seasonal observability” and confirm when during the spring semester would be a good time of year
to observe the target. Make note of those times as well as how you reached the decision (e.g. - Did you consider
just airmass or did you also need to consider the phase of the moon?)

10. Lastly, to help with you identifying the target at the telescope, put together a Finder Chart with a 20 arcminute wide field of view with a limit of about 17th magnitude. Use one of the following services:

• SIMBAD or

• the MAPS Catalog Finder Chart service or

• AAVSO Variable Star Plotter service.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/03_planning_observations/checking.rst, line 8.)

Todo
1. What project do you think you would like to attempt?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/03_planning_observations/choosing.rst, line 67.)

Todo
1. Suppose your dark frames were exposed for 30 seconds but your science images were 90 second exposures.

Explain how you would need to adjust the dark current images to use them for removing dark current from your
science image.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduce_science_overview.rst, line 44.)

Todo
1. If for some reason you wanted to could you still, even in case 2, do the data reduction the way it is in case 1?

Explain.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduce_science_overview.rst, line 59.)

Todo
1. Examine the FITS headers of the images. Which of the two data reduction cases in the previous discussion

applies here? Explain.

2. Reduce the science image.

(a) First, subtract of the bias/dark current or the dark frame (depending on which case applies here). Identify
one or more features of the image that visibly changed when you did this step of the calibration.
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(b) Second, use the flat field to correct the illumination. Describe what changes, if any you see in the image.
Hint: As with the previous step, you will need to use the image calculator.

3. Summarize, in your own words, the steps needed to reduce a science image.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduction_by_hand.rst, line 6.)

Todo
1. As a refresher, write down the three basic types of calibration you do to images.

2. Open one of the science images you have been asked to reduce.

3. Based on the exposure time and filter of the image, what calibration files will you need?

4. Are there additional calibration images you need to calibrate the calibration images in the previous question? If
yes, what are they?

5. Are there calibration images you need that do not depend on exposure time or filter? What are they?

You should end this section of questions with a clear list of the calibration images you will need (e.g. flats in the Z
filter, darks with an exposure time of 120 hours).

Check your list with any one of the instructors before you move on.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/automated_reduction.rst, line 53.)

Todo
1. How many bias frames should be included by the this automated tool? Note: there is no fancy way to figure this

out. Look at the file names.

2. Does the master bias image that you produced look like a master bias should? By this point you should have
some rough idea of what a master bias looks like and you should have notes on what the typical pixel value is in
a bias frame. Check both of those things.

3. Compare your master bias image to the appropriate reference_images to make sure they are really the same. Do
that by loading both your master bias and ours and using AstroImageJ to take the difference or the ratio (what
would you expect for either?).

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_bias.rst, line 25.)

Todo
1. Review the list of calibration files you made in Get organized before you get going. How many master dark

images will you need to make?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_dark.rst, line 4.)

Todo
1. How many dark frames should be included by the this automated tool for each of the master darks you need to

create? Note: there is no fancy way to figure this out. Look at the file names.
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2. Does the master dark image(s) that you produced look like a master dark should? By this point you should have
some rough idea of what a master dark looks like and you should have notes on what the typical pixel value is
in a dark frame. Check both of those things.

3. Compare your master dark image(s) to the appropriate reference_images to make sure they are really the same.
Do that by loading both your master dark(s) and ours and using AstroImageJ to take the difference or the ratio
(what would you expect for either?).

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_dark.rst, line 32.)

Todo
1. Review the list of calibration files you made in Get organized before you get going. How many master flat

images will you need to make? What filter(s)?

2. What calibration frames will you need to make your master flat?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_flat.rst, line 6.)

Todo
1. How many flat frames should be included by the this automated tool for each of the master flats you need to

create? Note: there is no fancy way to figure this out. Look at the file names.

2. Does the master flat image(s) that you produced look like a master flat should? By this point you should have
some rough idea of what a master flat looks like and you should have notes on what the typical pixel value is in
a flat frame. Check both of those things.

3. Compare your master flat image(s) to the appropriate reference_images to make sure they are really the same. Do that by loading both your master flat(s) and ours and using AstroImageJ to take the difference.

• NOTE: If there turn out to be tiny differences, they may appear to be more significant than they are
when displayed, since AstroImageJ scales the image to the range of values in the image. A better test
might be taking the RATIO of your flat versus the reference flat image if your flat and our reference
flat are just offset from each other by a tiny but constant fraction.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_flat.rst, line 31.)

Todo
1. How many science frames should be included by the this automated tool? Note: there is no fancy way to figure

this out. Look at the file names.

2. Does the calibrated science image look sensible? By now you should be able to recognize if there are obvious
defects (e.g. dust donuts)

3. Compare your science image(s) to the appropriate reference_images to make sure they are really the same.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/reduce.rst, line 30.)

Todo
1. If you choose 𝐶 = 0, what is the instrumental magnitude for the star you measured?
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2. Look at the table of magnitudes handed out (also available here). Does your instrumental magnitude match the
V magnitude of the star you chose? Should it?

3. What would you have to choose C to be for your magnitude to match the magnitude in the table?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/instrumental_mags_and_the_beauty_of_photometry.rst, line 24.)

Todo
1. Talk to someone who chose a different star than you did and calculate the difference in instrumental magnitude

between your two stars.

2. Compare your difference in instrumental magnitude to the difference in the reported magnitudes of the two stars
in the table.

3. Try looking up your two stars in simbad and write down their V magnitudes according to simbad.

• do a coordinate search

• one format for entering coordinates is like: 2.703738h+42.77795d

• RA is first, in decimal hours, followed by declination in decimal degrees

4. Does the magnitude difference as calculated from simbad match what you get from the table we provided? Does
it match your image?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/instrumental_mags_and_the_beauty_of_photometry.rst, line 48.)

Todo
1. What is the FWHM of the star you took the seeing profile of?

2. What does the FWHM mean? Answer both in terms of what the acronym means and an explanation in plain
english what it represents.

3. What aperture size was chosen? How large is it compared to the FWHM (e.g. 2X, or half)?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/photometry_aij.rst, line 21.)

Todo
1. Write down, from the measurement table, for the star you chose:

• the RA and Dec (in decimal hours and decimal degrees)

• net counts (Source-Sky)

• source radius

• minimum and maximum sky radius

• Sky counts/pixel

• Source Error

• Source SNR

2. What was the net number of photons received from the star in the aperture? Hint: Don’t forget about the gain.

3. Pay attention to the folks up front for a brief lecture about error and signal-to-noise ratio (SNR). Take useful
notes.
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4. Calculate the source error and SNR and compare to the values of each from AstroImageJ

5. What is the largest source of error?

6. Of the “noise” terms (dark, sky, read noise), which makes the largest contribution?

7. How could you reduce that source of noise?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/photometry_aij.rst, line 48.)

Todo
1. Add three columns to your data table, one for the instrumental magnitudes of each of the three stars for which

you have photometry. NOTE: AstroImageJ calls the columns that contain the net counts (i.e. 𝑁Source − 𝑁Sky)
something like Source-Sky_T1 or Source-Sky_T2. Use a value of zero for C.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 17.)

Todo
1. Make a graph with airmass on the horizontal axis and instrumental magnitude on the vertical axis, like BGO

Fig. 7.4. Use the “target” star.

• Display the points as points not a line like the book does.

• Excel will pick stupid default values for the airmass values; be sure to at least change the minimum value
to something sensible.

2. Add a trendline to each of the data series. In the options for the trend line:

• Display the fit equation

• Display 𝑅2

3. What would the instrumental magnitude of this star be if corrected for the atmosphere? Hint: What does 𝑚0

represent, physically (mathematically it is the y-intercept of the line you fit to the data)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 35.)

Todo
1. Add the instrumental magnitudes of the other two stars to your graph. The graph should have three sets of points

on it, one set for each of the three stars (i.e. three data series, in Excel-speak).

2. Add trendlines to the new data series.

3. Do all three stars experience the same extinction coefficient, k? Why do you think that is?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 59.)

Todo
1. Open the image “reference-positions.fit” to get the RA and Dec for each of the stars you look at and write them

down in your notebook.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/multi_aperture_photometry.rst, line 36.)
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Todo
1. Write down the FWHM, aperture size, inner sky radius and outer sky radius you chose.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/set_aperture_radius.rst, line 22.)

Todo
1. For my project to succeed, what do I need to actually accurately measure from my science images?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/data_processing_questions.rst, line 6.)

Todo
1. Calibrated Astrometry: Do I need to know where my objects actually are in the sky? Do I need to be concerned

with their motion? Note: None of your projects this year involved tracking moving objects, so this is not critical.
That said, it is a good idea to calibrate your astrometry so that you know where each point in your image actually
is in the sky. Luckily for you, we have already calibrated all your images astrometrically using a software
package called astrometry.net.

2. Calibrated Photometry: Do you need to calibrate your photometry so that it can be compared to others?
That is, do you need to report calibrated magnitudes or can you stick to instrumental magnitudes? If you need
calibrated magnitudes, how would you go about getting them? What standard stars will you use?

3. Atmospheric Extinction Corrections: Do you need to be concerned with determining the extinction and red-
dening per airmass for your target? If so, how could you determine it?

4. Galactic Extinction Corrections: Do you need to be concerned with determining the amount of Galactic
extinction or reddening to your target? Why or why not?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/data_processing_questions.rst, line 11.)

Todo
1. Do you need to stack images in order to bring out faint features in your images? If so, what images do you need

to stack to produce what final images. How will you make sure the stacked images are aligned?

• If you are stacking science images you will need to align them first. Instructions for aligning are at
http://physics.mnstate.edu/craig/astro_project/align.html#align-the-images

• If you need them, instructions for stacking are at http://physics.mnstate.edu/craig/image_stats/stats_1.html#different-
ways-of-combining-average-vs-median

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/image_processing_questions.rst, line 6.)

Todo
1. For my project to succeed, what do I need to actually accurately measure from my science images?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/introduction.rst, line 25.)
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CHAPTER 8

Planning How You Turn Science Images Into Science

Contents:

8.1 Introduction

• We will assume you have gotten your science images through the initial calibration where you remove the biases,
correct for dark current, and apply flat fielding corrections so that the illumination on the CCD is uniform.

• Our goal for today is to help you decide just what you need to do to turn your initially calibrated science images into science. This means:

1. You need to figure out if you need to do more with the actual science images (e.g. stacking) to get the
final images you will be working with.

2. Assuming you will be performing photometric analysis of your images, i.e. measuring fluxes of your
images, you need to figure out what, if any, photometric corrections you need to apply to your images.

• The Tools You Will Need: In order to get your initially calibrated science images into science, you may need to use any or all of the following:

– AstroImageJ,

– JSkyCalc,

– Microsoft Excel or some equivalent spreadsheet program,

– careful thought to plan out the reductions.

• BIG HINTS:

– Always take good notes describing what you are doing. The level of detail should be such that some-
one else could reproduce your work based on your notes.

– Years of experience have shown us that we _will_ make mistakes ... many mistakes. Its nothing
personal, its just part of human nature. However, you can prepare for making mistakes by always
doing your analysis in such a way that you can back up and restart it if you discover an error. The
key to this is NEVER OVERWRITE DATA FILES! When you are starting along a new analysis,
image reduction, etc., always create new files, never overwrite old ones. If you are introducing a new
calculation to a spreadsheet, make a backup of the spreadsheet before you make extensive changes.
Always give yourself a way to recover from errors if you can.
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8.1.1 The Big Question

Be ready to answer this question by ~12:15.

Todo
1. For my project to succeed, what do I need to actually accurately measure from my science images?

8.2 Image Processing Questions

We will start by assuming you now have properly calibrated science images, that is, images that have been bias-
subtracted, dark-subtracted, and flat-fielded. You need to ask yourself some questions regarding any need you might
have for additional images.

Todo
1. Do you need to stack images in order to bring out faint features in your images? If so, what images do you need

to stack to produce what final images. How will you make sure the stacked images are aligned?

• If you are stacking science images you will need to align them first. Instructions for aligning are at
http://physics.mnstate.edu/craig/astro_project/align.html#align-the-images

• If you need them, instructions for stacking are at http://physics.mnstate.edu/craig/image_stats/stats_1.html#different-
ways-of-combining-average-vs-median

Once you have answered the question(s) above and have addressed them, then you know what you need to create your
final science images.

8.3 Data Processing Questions

Assuming you have your final science images, there are some critical questions you need to answer in order to know
what approach to take next. The first question is the most critical and for some of you the hardest to answer:

Todo
1. For my project to succeed, what do I need to actually accurately measure from my science images?

Once you have answered what you need to actually accurately measure from your science images, you can start
considering the various “calibrations” and “corrections” we have investigated in our course thus far.

Todo
1. Calibrated Astrometry: Do I need to know where my objects actually are in the sky? Do I need to be concerned

with their motion? Note: None of your projects this year involved tracking moving objects, so this is not critical.
That said, it is a good idea to calibrate your astrometry so that you know where each point in your image actually
is in the sky. Luckily for you, we have already calibrated all your images astrometrically using a software
package called astrometry.net.

2. Calibrated Photometry: Do you need to calibrate your photometry so that it can be compared to others?
That is, do you need to report calibrated magnitudes or can you stick to instrumental magnitudes? If you need
calibrated magnitudes, how would you go about getting them? What standard stars will you use?

3. Atmospheric Extinction Corrections: Do you need to be concerned with determining the extinction and red-
dening per airmass for your target? If so, how could you determine it?
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4. Galactic Extinction Corrections: Do you need to be concerned with determining the amount of Galactic
extinction or reddening to your target? Why or why not?

By the way, it is actually better in a very real way to consider these question of what you need to do with your data
to turn it into science while planning just what observations you will need to make! It would be bad to discover you
were missing critical data for reducing your project.

8.4 Questions

Todo
1. For each file name below explain why the name would or would not match the pattern twi-.*bias.*

• Twi-bias.fit

• twi-diffuser-flat-001bias.fit

• twi-diffuser-flat-001bias_flt.fit

• twi-diffuser-flat-001bIas.fit

2. Look at the list of the files in the folder for_gain. For each of the items below come up with a pattern that
matches the right files. Check your patterns by starting to open an image sequence in AstroImageJ, selecting the
folder for_gain, entering the pattern in the right place, and verifying that the correct number of files matches.

(a) All bias images that have “twi” in the name (should be 11 files)

(b) The images in the R band (R is in the file name) that also have “flood” in the name and are number 001
through 003 (should be 3 files).

(c) The images in the I band with “flood” in the name (10 items)

(d) The images in the I band with “flood” in the name whose number is odd (001, 003, etc) (should be 5
images)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/aij_sequences.rst, line 55.)

Todo
1. Write down the names of the images you chose.

2. Select a region and write down its width, height, and x and y position.

3. Find the average pixel value in that region in each image you have open. Write them down, clearly indiciating
which measure goes with which image.

4. Calculate the difference between the two bias images.

5. Calculate the difference between the two flat images.

6. Measure the standard deviation in the region you chose in each of the two difference images. Write the result
down, clearly indicating which measurement goes with which difference image.

7. Calculate the gain for the CCD using the formula in Howell’s book.

8. Calculate the read noise for the CCD using the formula in Howell’s book.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/gain_calc_detail.rst, line 24.)
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Todo
1. Imagine subtracting an image from itself. What should the result be? Use AstroImageJ to subtract an image

from itself. Does the result match your expectaion?

2. Imagine dividing an image by itself. What should the result be? Use AstroImageJ to divide an image by itself.
Does the result match your expectation.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_arithmetic.rst, line 13.)

Todo
1. Where is the origin used for the x and y position? In other words, where in the image is the point (0,0)?

2. What is the position of the center of the image?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_measurements.rst, line 18.)

Todo
1. Measure the mean pixel value and the standard deviation of the pixel value for one of the images you have open.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/imagej_measurements.rst, line 37.)

Todo
1. Make a histogram for a single bias image. Note the width of the bias histogram, which is twice the standard

deviation, and the mean.

2. Combine four of the bias images. Do this by:

• clicking on sequence window so that it is on top

• clickking on the AstroImageJ toolbar to make sure the correct menus are displayed

• selecting Z-Project from the Stacks menu in the Image menu (i.e. Image -> Stacks -> Z-Project) and...

• ...choosing appropriate values for the starting and ending image in the sequence, and...

• ...choose average as the method of combining.

• Be sure to write down the name of the combined image.

3. Make a histogram of the combination of four bias images. Compare the mean and standard deviation of the
distribution for the combined images with the same numbers for the single image.

4. Repeat for 8 bias images; note the mean and standard deviation.

5. Repeat again for all 16 bias images; note the mean and standard deviation.

6. Describe in words:

(a) How the histogram changes as you increase the number of images in the stack.

(b) How the mean changes as you increase the number of images.

(c) How the standard deviation changes as you increase the number of images.
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7. For this type of error it can be shown that the amount of noise (i.e. the standard deviation) should be inversing
proportional to the square root of the number of images. Does this seem to be true, at least roughly, for the
histograms you just compared?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/stats_1.rst, line 18.)

Todo
1. Combine four images using median to Z-project the images, and make a histogram of the combined image.

2. Combine 16 images using median to Z-project the images, and make a histogram of the combing image.

3. Does the pattern you observed for the change in noise as you increase the number of images still hold for median
combining?

4. Compare the mean and standard deviation of these histograms with the corresponding mean and standard devia-
tion from the images combined using the average. Which results in less noise, combing by average or combining
by median?

5. Why might you median combine images even though there is slightly less noise if you combine images by
averaging?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/01_image_statistics/stats_1.rst, line 44.)

Todo
1. What is different about the first image in the sequence? Look near pixel coordinates (1480, 820)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 12.)

Todo
1. Can you see the defect in the image made by averaging the stack? Why?

2. Can you see the defect in the image made by median combining the stack? Why?

3. In which stacked image is the defect more visible, the average or the median?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 26.)

Todo
1. If you haven’t yet, normalize the sequence of flat images you have open. Is the average pixel value in the image

roughly the same in each image after normalization? Why isn’t the average pixel value the same as the median
pixel value you set in the normalization dialogue box?

2. Suppose one of the original images had a median pixel value of 23,200 and that you want to have want the
median after normalization to be 2. Describe in detail what you need to do to the image to normalize (detail in
the sense of the math operations you would need to carry out if you were to normalize by hand, not details of
how to do it in AstroImageJ) and explain why your answer is correct.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/cosmic_ray.rst, line 52.)

Todo

8.4. Questions 107



ObsAstro Documentation, Release 0.1

1. Make a master bias frame using all of the bias frames in the folder and save the result as a FITS image. Make a
note of:

• Which files went into the master.

• How you combined the files.

• How many files went into the master.

• What you called the master bias frame.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/masters.rst, line 15.)

Todo
1. Make a master dark. Use all of the files in the float folder that start with twi and have D15 in the name.

Combine using a median, and save the result as a FITS image. Make a note of:

• Which files went into the master.

• How you combined the files.

• What the exposure time was for these darks.

• What you called the master dark frame.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/masters.rst, line 43.)

Todo
1. Double-check the exposure time of the flat you opened. Does it match the exposure time of the master dark you

created?

2. Use the image calculator to subtract your master dark from the flat frame that you opened.

3. In principle, the pixel values are now all due to light that fell on the CCD. Pick a pixel, and convert the value
from ADU to photons using the gain you calculated earlier. How many photons was it?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/02_master_frames/reduce_a_flat.rst, line 8.)

Todo
1. Open up SIMBAD and look up the information on your target. Make note of any other common names for your

target, its position (in J2000 coordinates), and its magnitude (NOTE: You may want to save a bookmark to your
object’s SIMBAD page).

2. Write down a list of the kind of observations you will need to make for your project (NOT INCLUDING the
biases, darks, and flats you would have to shoot for any telescopic observations). Include the number of images
and which filters you will need to use. You should also note if the images need to be in very dark skies or if
you can shoot in brighter (possibly moonlit) skies. WARNING: One part of planning we are not addressing yet
is estimating how long you need to make your exposures. This is critical because it affects how much you can
actually shoot each night. We will be addressing this next week.

3. Edit the my_objects_list.txt text file to include your target(s) as the first object(s) on the list. You can also delete
any lines for objects you do not intend to observe if you wish.

4. Open up jSkyCalc and load the objects list. Set the date in jSkyCalc to the appropriate date. When is sunset and
sunrise for the night you are checking? You may need to know this to plan for twilight flats.
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5. When does twilight end (evening) and begin (morning)? You may need these times to plan for twilight flats and
to know when science observing can occur.

6. Set the time in jSkyCalc to twilight for that evening. What is the Hour Angle of your target? What does this
mean?

7. What is the airmass profile for your target? What time of night will your target be high enough for it to be a
good time to observe your object, if any? Clarify how you reached this decision (e.g. - What did you look for to
make this decision?)

8. Is the moon going to be a problem for you on March 1-3?

9. Check the “seasonal observability” and confirm when during the spring semester would be a good time of year
to observe the target. Make note of those times as well as how you reached the decision (e.g. - Did you consider
just airmass or did you also need to consider the phase of the moon?)

10. Lastly, to help with you identifying the target at the telescope, put together a Finder Chart with a 20 arcminute wide field of view with a limit of about 17th magnitude. Use one of the following services:

• SIMBAD or

• the MAPS Catalog Finder Chart service or

• AAVSO Variable Star Plotter service.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/03_planning_observations/checking.rst, line 8.)

Todo
1. What project do you think you would like to attempt?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/03_planning_observations/choosing.rst, line 67.)

Todo
1. Suppose your dark frames were exposed for 30 seconds but your science images were 90 second exposures.

Explain how you would need to adjust the dark current images to use them for removing dark current from your
science image.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduce_science_overview.rst, line 44.)

Todo
1. If for some reason you wanted to could you still, even in case 2, do the data reduction the way it is in case 1?

Explain.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduce_science_overview.rst, line 59.)

Todo
1. Examine the FITS headers of the images. Which of the two data reduction cases in the previous discussion

applies here? Explain.

2. Reduce the science image.
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(a) First, subtract of the bias/dark current or the dark frame (depending on which case applies here). Identify
one or more features of the image that visibly changed when you did this step of the calibration.

(b) Second, use the flat field to correct the illumination. Describe what changes, if any you see in the image.
Hint: As with the previous step, you will need to use the image calculator.

3. Summarize, in your own words, the steps needed to reduce a science image.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/04_reduction_by_hand/reduction_by_hand.rst, line 6.)

Todo
1. As a refresher, write down the three basic types of calibration you do to images.

2. Open one of the science images you have been asked to reduce.

3. Based on the exposure time and filter of the image, what calibration files will you need?

4. Are there additional calibration images you need to calibrate the calibration images in the previous question? If
yes, what are they?

5. Are there calibration images you need that do not depend on exposure time or filter? What are they?

You should end this section of questions with a clear list of the calibration images you will need (e.g. flats in the Z
filter, darks with an exposure time of 120 hours).

Check your list with any one of the instructors before you move on.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/automated_reduction.rst, line 53.)

Todo
1. How many bias frames should be included by the this automated tool? Note: there is no fancy way to figure this

out. Look at the file names.

2. Does the master bias image that you produced look like a master bias should? By this point you should have
some rough idea of what a master bias looks like and you should have notes on what the typical pixel value is in
a bias frame. Check both of those things.

3. Compare your master bias image to the appropriate reference_images to make sure they are really the same. Do
that by loading both your master bias and ours and using AstroImageJ to take the difference or the ratio (what
would you expect for either?).

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_bias.rst, line 25.)

Todo
1. Review the list of calibration files you made in Get organized before you get going. How many master dark

images will you need to make?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_dark.rst, line 4.)

Todo
1. How many dark frames should be included by the this automated tool for each of the master darks you need to

create? Note: there is no fancy way to figure this out. Look at the file names.
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2. Does the master dark image(s) that you produced look like a master dark should? By this point you should have
some rough idea of what a master dark looks like and you should have notes on what the typical pixel value is
in a dark frame. Check both of those things.

3. Compare your master dark image(s) to the appropriate reference_images to make sure they are really the same.
Do that by loading both your master dark(s) and ours and using AstroImageJ to take the difference or the ratio
(what would you expect for either?).

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_dark.rst, line 32.)

Todo
1. Review the list of calibration files you made in Get organized before you get going. How many master flat

images will you need to make? What filter(s)?

2. What calibration frames will you need to make your master flat?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_flat.rst, line 6.)

Todo
1. How many flat frames should be included by the this automated tool for each of the master flats you need to

create? Note: there is no fancy way to figure this out. Look at the file names.

2. Does the master flat image(s) that you produced look like a master flat should? By this point you should have
some rough idea of what a master flat looks like and you should have notes on what the typical pixel value is in
a flat frame. Check both of those things.

3. Compare your master flat image(s) to the appropriate reference_images to make sure they are really the same. Do that by loading both your master flat(s) and ours and using AstroImageJ to take the difference.

• NOTE: If there turn out to be tiny differences, they may appear to be more significant than they are
when displayed, since AstroImageJ scales the image to the range of values in the image. A better test
might be taking the RATIO of your flat versus the reference flat image if your flat and our reference
flat are just offset from each other by a tiny but constant fraction.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/master_flat.rst, line 31.)

Todo
1. How many science frames should be included by the this automated tool? Note: there is no fancy way to figure

this out. Look at the file names.

2. Does the calibrated science image look sensible? By now you should be able to recognize if there are obvious
defects (e.g. dust donuts)

3. Compare your science image(s) to the appropriate reference_images to make sure they are really the same.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/05_automated_reduction/reduce.rst, line 30.)

Todo
1. If you choose 𝐶 = 0, what is the instrumental magnitude for the star you measured?
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2. Look at the table of magnitudes handed out (also available here). Does your instrumental magnitude match the
V magnitude of the star you chose? Should it?

3. What would you have to choose C to be for your magnitude to match the magnitude in the table?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/instrumental_mags_and_the_beauty_of_photometry.rst, line 24.)

Todo
1. Talk to someone who chose a different star than you did and calculate the difference in instrumental magnitude

between your two stars.

2. Compare your difference in instrumental magnitude to the difference in the reported magnitudes of the two stars
in the table.

3. Try looking up your two stars in simbad and write down their V magnitudes according to simbad.

• do a coordinate search

• one format for entering coordinates is like: 2.703738h+42.77795d

• RA is first, in decimal hours, followed by declination in decimal degrees

4. Does the magnitude difference as calculated from simbad match what you get from the table we provided? Does
it match your image?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/instrumental_mags_and_the_beauty_of_photometry.rst, line 48.)

Todo
1. What is the FWHM of the star you took the seeing profile of?

2. What does the FWHM mean? Answer both in terms of what the acronym means and an explanation in plain
english what it represents.

3. What aperture size was chosen? How large is it compared to the FWHM (e.g. 2X, or half)?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/photometry_aij.rst, line 21.)

Todo
1. Write down, from the measurement table, for the star you chose:

• the RA and Dec (in decimal hours and decimal degrees)

• net counts (Source-Sky)

• source radius

• minimum and maximum sky radius

• Sky counts/pixel

• Source Error

• Source SNR

2. What was the net number of photons received from the star in the aperture? Hint: Don’t forget about the gain.

3. Pay attention to the folks up front for a brief lecture about error and signal-to-noise ratio (SNR). Take useful
notes.
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4. Calculate the source error and SNR and compare to the values of each from AstroImageJ

5. What is the largest source of error?

6. Of the “noise” terms (dark, sky, read noise), which makes the largest contribution?

7. How could you reduce that source of noise?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/06_photometry_intro/photometry_aij.rst, line 48.)

Todo
1. Add three columns to your data table, one for the instrumental magnitudes of each of the three stars for which

you have photometry. NOTE: AstroImageJ calls the columns that contain the net counts (i.e. 𝑁Source − 𝑁Sky)
something like Source-Sky_T1 or Source-Sky_T2. Use a value of zero for C.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 17.)

Todo
1. Make a graph with airmass on the horizontal axis and instrumental magnitude on the vertical axis, like BGO

Fig. 7.4. Use the “target” star.

• Display the points as points not a line like the book does.

• Excel will pick stupid default values for the airmass values; be sure to at least change the minimum value
to something sensible.

2. Add a trendline to each of the data series. In the options for the trend line:

• Display the fit equation

• Display 𝑅2

3. What would the instrumental magnitude of this star be if corrected for the atmosphere? Hint: What does 𝑚0

represent, physically (mathematically it is the y-intercept of the line you fit to the data)

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 35.)

Todo
1. Add the instrumental magnitudes of the other two stars to your graph. The graph should have three sets of points

on it, one set for each of the three stars (i.e. three data series, in Excel-speak).

2. Add trendlines to the new data series.

3. Do all three stars experience the same extinction coefficient, k? Why do you think that is?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/excel_graphs.rst, line 59.)

Todo
1. Open the image “reference-positions.fit” to get the RA and Dec for each of the stars you look at and write them

down in your notebook.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/multi_aperture_photometry.rst, line 36.)
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Todo
1. Write down the FWHM, aperture size, inner sky radius and outer sky radius you chose.

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/07_photometry_automated/set_aperture_radius.rst, line 22.)

Todo
1. For my project to succeed, what do I need to actually accurately measure from my science images?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/data_processing_questions.rst, line 6.)

Todo
1. Calibrated Astrometry: Do I need to know where my objects actually are in the sky? Do I need to be concerned

with their motion? Note: None of your projects this year involved tracking moving objects, so this is not critical.
That said, it is a good idea to calibrate your astrometry so that you know where each point in your image actually
is in the sky. Luckily for you, we have already calibrated all your images astrometrically using a software
package called astrometry.net.

2. Calibrated Photometry: Do you need to calibrate your photometry so that it can be compared to others?
That is, do you need to report calibrated magnitudes or can you stick to instrumental magnitudes? If you need
calibrated magnitudes, how would you go about getting them? What standard stars will you use?

3. Atmospheric Extinction Corrections: Do you need to be concerned with determining the extinction and red-
dening per airmass for your target? If so, how could you determine it?

4. Galactic Extinction Corrections: Do you need to be concerned with determining the amount of Galactic
extinction or reddening to your target? Why or why not?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/data_processing_questions.rst, line 11.)

Todo
1. Do you need to stack images in order to bring out faint features in your images? If so, what images do you need

to stack to produce what final images. How will you make sure the stacked images are aligned?

• If you are stacking science images you will need to align them first. Instructions for aligning are at
http://physics.mnstate.edu/craig/astro_project/align.html#align-the-images

• If you need them, instructions for stacking are at http://physics.mnstate.edu/craig/image_stats/stats_1.html#different-
ways-of-combining-average-vs-median

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/image_processing_questions.rst, line 6.)

Todo
1. For my project to succeed, what do I need to actually accurately measure from my science images?

(The original entry is located in /var/build/user_builds/image-analysis/checkouts/explicit-
fancybox/08_planning_reductions/introduction.rst, line 25.)
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CHAPTER 9

Indices and tables

• genindex

• modindex

• search
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